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1. Memento Presentation

»2 Memento

Fvent Logging Tool

Memento is an advanced system for logging event messages. It greatly facilitates the debugging
of machine vision applications using Euresys frame grabbers. It is non-intrusive as the required
CPU load is extremely low.

The Memento system is made up of three main components: the Memento driver, the Memento
application and the Memento producer(s).

Memento Application - CONSOLE Mode 4

Read Viewer Memento Console
Filters Buffer

Producers

MultiCam Memento Driver
drivers & libraries| 4
Coaxlink Filters
driver & library ?*o
User

application o

Memento

application

Data Selection
Filter

Memento Function Blocks and Data Flow
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The Memento system works as described below and shown on the above schema:

1.

The Memento Ring Buffer is a common memory space that the Memento driver reserves on
the computer and makes it known to the frame grabber drivers and libraries, as well as the
user space applications.

The Memento Producers, that means the frame grabber drivers and libraries, the user space
applications and the Memento application itself, inject event messages - the Memento
Traces - into the ring buffer.

They time-stamp the Memento traces using a common time scale - the Memento Time Scale.

The Write Filters, applied upstream of the ring buffer, allow you to filter the messages written
in the ring buffer.

The Memento application you can access in Console Mode or GUI Mode allows you to view
recent and past traces.

The Read Filters, applied upstream of the Memento application, make it possible to filter the
traces loaded into the Memento Viewer Buffer.

The Memento Viewer Buffer stores the traces to be made available in the Memento
application.

The Rules, applied in the Memento application, make it possible to highlight or hide traces in
the Memento application.

You can also dump the traces from the ring buffer using the Memento Dump Mode. This
dump mode is available from the Console or GUl interfaces.



Memento @euresys

a TKH Vision brar

2. Starting Memento

NOTE
You will find detailed information on how to set up Memento and perform
the initial configuration in the Getting Started guide (D602).

Start adding data to the ring buffer

When the PC hosting the Memento driver is running, the traces from the active producers start
being added to the ring buffer as soon as one of the producers sends Memento traces to the
ring buffer.

As long as past activity is still available in the ring buffer, you will be able to view past traces in
the Memento application (GUI or Console mode) even if it was closed when the traces were
added.

Start the Memento application

To start Memento (graphical user interface), do one of the following actions:
e Click the Memento icon on the desktop.
e Select the application from the Windows Start Menu > Euresys Memento > Memento.

e Use the following command line from the Memento console: memento gui --hide-console.

Options from the Windows Start menu

From the Windows Start Menu > Euresys Memento, you have a quick access to some options to
quickly perform a ring buffer configuration or save traces to a dump file:

Command Description

This generates a .zip file including the memento dump with all the data
Record Memento currently stored in the ring buffer, as well as the data collected by the
and XPerftraces Windows Performance Monitoring tools.

This option is only relevant on Windows.

Reset Memento
to Default
Verbosity Level

This resets the ring buffer configuration to the Default profile.
See Setting up the Driver in the Getting Started guide (D602).

Set Memento to
Highest
Verbosity Level

This sets the ring buffer configuration to the Verbose profile.
See Setting up the Driver in the Getting Started guide (D602).

Start Memento  This creates a dump file where all new data added to the ring buffer are
Logging stored.
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Command Description
See the section Saving Traces (GUI) in the User Guide (D603) and (Console) in
the Reference Manual (D604) if you want to define additional parameters for
your dump file.
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3. Touring the Interface

This section provides an overview on the user interface mode of the Memento application.
The Memento application helps you among others to:

e filter traces to display and highlight the most relevant events in your processes.

e search for traces based on their content or their time stamp.

e rapidly spot errors or critical traces on a plot showing the recent activity and on a plot
displaying the number of events according to their criticality.

e investigate an issue by analyzing process-related events and state changes displayed as
waveforms.

e save traces from the current process to a dump file for further investigation.

3.1. Overview of Memento User Interface

Layout of the Memento user interface

(©) Euresys Memento 105051 - 8 X

Aa [ RE Search: | Verbosity Fitter: )= RingFiters.. | Highiighting Fiers..

s
8daZ2 5052
: total 162703, history 18320

Memento application - GUI mode - Main window
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Control Bar: a set of buttons, check boxes, text and slider controls.
Activity Plot: an area showing a graphical representation of the recent activity.

Message Plot: an area showing a graphical representation of a set of message traces.

> wbh

Analyzer Plot: an area showing a graphical representation of process-related waveforms. This
area is only displayed when the Analyzer is enabled and open.

5. Tooltip Area: a text area showing the message corresponding to the position of the mouse
pointer, possibly completed with tooltip data.

6. Message List: a table showing a time-ordered list of messages with their attributes.

7. Status Bar: statistical and status information.

3.2. Control Bar

¥ Az [ RE Search: [UTC ~]  config.. | Following ‘ Run | Clear Go Back.. | =

Starting from the left side, the Control bar contains the following controls:

Message search controls

[~ Aa [ RE Search: | j

Use this control to search on traces displayed in the message list.

You can use the Aa and RE search options respectively for case-sensitive searches and for
searches based on Perl-like regular expressions.

See the section "Search for and Find back Traces" on page 28 for more information on the
search syntax and command shortcuts.

Config

Config...

Use this button to access the Memento Configuration window, that gives access to the various
filters and rules:

Memento Configuration — %
File Edit

Memento Flow

Memento producers = Write Filters | = Memento storage (ring) = Read Filters | = Memento application — -* Action

e The Write filters allow you to view or refine the configuration settings for adding messages
into the ring buffer.

See the section "Filter Traces for the Memento Storage" on page 45 for detailed information.
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e The Read filters allow you to restrict or extend the number of messages to be displayed in the
Memento application.

See the section "Filter Traces for the Memento Application" on page 48 for detailed
information.

e The Rules allow you trigger actions (highlight or hide in Memento application, stop Go Back
or start/stop dump) when a trace matches settings defined in the rule.

See the section "Trigger Actions on Traces" on page 52 for detailed information.

Follow | Following button

Follow | | Following

Use this toggle button to control whether the message list is automatically scrolled down.
This function makes it possible to constantly display the most recent messages in the list or not.

See the section "Monitor the Activity in Real Time" on page 18 for detailed information.

Run | Pause button

‘ Run || ‘ Pause |

Use this toggle button to control whether the most recent messages are extracted from the ring
buffer to fill in the viewer buffer, and consequently whether the Memento application is fed with
these new messages from the viewer buffer.

See the section "Monitor the Activity in Real Time" on page 18 for detailed information.

Clear button

Clear

Use this button to clear all messages in the Memento application. This corresponds to clearing
the viewer buffer.

Go back button

Go Back...

Use this button to go back in time and display older messages in the Memento application.
Going back automatically clears the viewer buffer before reloading it with old messages still
available in the ring buffer.

See the section "Monitor the Activity in Real Time" on page 18 for detailed information.
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Menu button

Click this button to access the following functions:

Open Memento dump to select a dump file to open.
Load Memento session to restore a previously saved Memento session from a .memento file.

Save Memento session to save, into a .memento file, the global Memento preferences, filters
and rules configurations, comments, bookmarks and Analyzer settings together with
Memento data.

o When you are working on a dump file, the saved Memento data include all data from the
dump file.

o When you are working with the data from the ring buffer, the saved Memento data
include all data of the selected boot session (defined in the Go Back dialog box), and
more recent ones, if any.

Clear search history to clear the history of the search strings in the Search field.

Clear all user settings to clear the history of all user settings (read filters, rules, layout
settings). The write filters are not reset with this control.

Clear analyzer settings to clear the Analyzer configuration.
Clear history before bookmark to clear the message list before the selected bookmark.

See also "Administration Tools" on page 77 for more information on the four functions
above-mentioned.

Dump memento data to file... to dump the content of the ring buffer to a file.

Dump memento section between bookmarks to dump the content of the ring buffer between
the time stamps of the selected bookmarks.

Dump memento selection to file to dump the content of the ring buffer between the time
stamps of the first and last selected messages.

See "Back up Memento Traces" on page 65 for more information on the three functions
above-mentioned.

Inject current time trace to inject a UTC time trace into the ring buffer.
See "Using Time Information" on page 76.

Reload Trace Definition to reload the trace dictionary used for mapping the trace references
stored in the ring buffer with the actual trace description displayed in the Memento
application.

See "Administration Tools" on page 77.

Enable analyzer to extract the Analyzer traces to the viewer buffer and give access to the
Analyzer controls in the Memento application.

Show analyzer to open the Analyzer Configurator and Analyzer Plot area, and add Analyzer
traces in the Analyzer Plot area and in the message list.

See "Activate the Analyzer" on page 33 and "Configure Traces for Analysis" on page 36 for
more information on the Analyzer module.
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e Automatically set Memento Writer Filters to None upon Pause to change the behavior of the
Pause/Run toggle button.

If this option is selected, the emission of traces is disabled when you press the Pause button
and until you press it again. In other words, the Write Filters are temporarily set to the profile
None.

e About to view the version number of Memento.

3.3. Activity Plot

The Activity Plot area of the Memento application shows the recent message logging activity as
a graph:

Horizontal axis

The horizontal axis of the activity plot represents the time. The axis has a fixed scale and
subdivided with major divisions of 1 minute and minor divisions of 2.5 seconds.

The major divisions are labeled with the Memento time value. The time value represents the
time elapsed since you have started the Memento application.

The activity plot shows the activity in the last seven minutes. The rightmost end of the time
scale is the current time.

Vertical axis

The vertical axis of the activity plot represents the number of messages per second that are
effectively logged into the Memento ring buffer.

The axis is a logarithmic scale covering five decades:
e The first horizontal grid line is at 10 events per second
e The second horizontal grid line is at 100 events per second

Plot display

The plot display is composed of trace dots or lines. The dot or line color reflects the severity
level of the logged messages:

e The green color represents logged messages that are less critical than Notice.
e The yellow color represents Notice messages.

e The orange color represents Warning messages.

e The red color represents logged messages that are more critical than Warning.

You can click the activity plot to plot messages close to that point in time in the message plot.
This allows you to investigate errors appearing in red in the activity plot area.
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Activity monitoring mode

The activity plot has two operation modes available by right-clicking the activity plot area:
e Accurate Activity Monitoring Mode (Default mode)

This mode takes into account the verbosity level of messages to generate the activity plot.
Consequently the notice, warning and more critical messages are represented respectively
by yellow, orange or red dots in the plot.

e Fast Activity Monitoring mode

This mode does not analyze the verbosity level of messages to generate the activity plot.
Consequently the plot is only represented as a green line, no matter how critical they are.
This mode can be useful if you need to alleviate the CPU workload.

3.4. Message Plot

The Message Plot area of the Memento GUI gives a time plot representing a set of traces.

Horizontal Axis

The horizontal axis of the message plot represents the time. The axis has a variable scale with
adaptive major and minor divisions.

Vertical Axis

The vertical axis of the message plot represents the verbosity level: the traces are represented
according to their verbosity level on the various horizontal lines displayed in the message plot.

e Traces with the highest verbosity level (Verbose) - the least critical - are represented on the
first level from the bottom.

e Traces with the lowest verbosity level (Critical) - the most critical - are represented on the
seventh level from the bottom.

Trace Symbols

A trace is represented by the symbol =. The symbol color matches the background color settings
defined in the default Memento Rules (rules 2 to 7).

The portion of the message plot represented below shows:

e First several Debug traces (2nd level from bottom) and Info traces (3rd level from bottom)
have been issued at the same time as an Error trace in red (6th level from bottom).

e Straight after these traces, a Debug and Info traces were issued at the same time as a Warning
trace in orange (5th level from the bottom).
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3.5. Analyzer Plot

The Analyzer Plot area of the Memento application displays waveforms corresponding to
specific types of events you want to analyze.

Once you have selected these types of events in the Analyzer configuration, the corresponding
waveforms are displayed in the Analyzer plot.

Horizontal axis

The horizontal axis of the Analyzer plot represents the time. The axis has a variable scale with
adaptive major and minor divisions.

Vertical Axis

The vertical axis of the Analyzer plot shows the waveforms selected in the Analyzer
configuration.

For the waveforms selected in the Analyzer configuration, the following information is
displayed:

e the name of the waveforms on the left, and the reference to the related frame grabber card,
connector and possibly stream.

e the waveform displaying the occurred events (Analyzer traces). These events can belong to
one of the following types:

o Process start (level up)
o Process reset (level down)
o Counter (calculated value)
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3.6. Message List

The Message List area of the Memento GUI displays a time-ordered list of messages.

The message list is represented as a table with one row per message, and several columns
including the message-related data fields.

Delta

[po [0 |c.c.Kind | Level | Trace
+2827.135523 €492 660 API Info GCReadPort (PORT_HANDLE hPort = 7, uintéd4_t ilAddress = 0x0000000000002070, void *pBuffer, size_t *piSize -> 32)
+2827.135523 €492 660 AFI Debug Port handle 7: DEVICE ACCESS_CONTRCL => readable
+2927.135523 €452 660 API Verbose
+2927.135524 6452 660 2p1 Info GCReadPort (PORT nPort = 7, uinté4_t iAddress = 0x0000000000002090, void *pBuffer, size_t *piSize -> 32)
+2827.135524 €492 660 API Debug Port handle 7: CCESS_CONTROL => readable
+2827.135524 €492 660 API Verbose
+2927.135525 6452 660 np1 Info GCReadPort (PORT_HANDLE hPort = 7, uinté4_t iAddress = 0x00000000000020b0, void *pBuffer, size_t *piSize -> 18)
+2927.135525 6452 660 2p1 Debug  Port handle 7: DEVICE_ACCESS_CONTROL => readable
+2927.135525 6492 660 API Verbose
+2827.135526 €492 660 API Info GCReadPort (PORT_E uinté4_t iAddress = 0x00000000000020c0, veid *pBuffer, size t *piSize -> 1€)
+2827.135526 €492 660 AFI Debug Port handle 7:
+2927.135527 6452 660 API Verbose
+2927.135925 6452 660 ap1 Info GCReadPort (PORT_HANDLE hPort = 7, uinté4_t iAddress = 0x0000000000004004, void *pBuffer, size_t *piSize -> 4)
+2827.135934 €492 660 API Debug Port handle 7: DEV ._ACCESS_CONTRCL => readable
+2827.135934 €482 660 API Verbose
+2827.135938 €492 660 AFI Info GCReadPort (PORT_E 7, uinté4_t iAddress = 0x0000000000004008, void *pBuffer, size_t *piSize -> &)
+2927.135935 6452 660 2p1 Debug  Port handle 7: CESS_CONTROL => readable
+2927.135939 €492 660 API Verbose
+2927.135940 6452 660 apI Info GCReadPort (PORT_HANDLE hPort = 7, uinté4_t iAddress = 0x000000000000400c, void *pBuffer, size_t *piSize > 4)
+2827.135940 €492 660 API Debug Port handle 7: DEV ._ACCESS_CONTRCL => readable
+2827.135940 €452 660 API Verbose
+2827.135941 €492 660 AFI Info GCReadPort (PORT_E hPort = 7, uinté4_t iAddress = 0x0000000000004010, void *pBuffer, size_t *piSize -> &)
+2927.135942 6452 660 2p1 Debug  Port handle 7: CCESS_CONTROL => readable
+2927.135942 €492 660 API Verbose
+2927.135943 6452 660 apI Info GCReadPort (PORT_HANDLE hPort = 7, uinté4_t iAddress = 0x0000000000004014, void *pBuffer, size_t *piSize -> 4)
+2827.135943 €492 660 API Debug Port handle 7: DEV ._ACCESS_CONTRCL => readable
+2827.135943 6452 660 API Verbose
+2927.135924 6452 660 np1 Info GCReadPort (EORT, Tt = 7, uinté4_t iAddress = 0x0000000000004018, void *pBuffer, size_t *piSize -> )
+2927.135944 6452 660 API Debug Port handle 7 55_t NTROL => readable
+2927.135944 6452 660 API Verbose
+2927.135945 €492 660 API Info GCReadPort (PORT_HANDLE hPort » uincé4_t iAddress = 0x00000000000040lc, void *pBuffer, size_t *piSize -> 4)
+2827.135945 €492 660 API Debug Port handle 7: DEVICE ACCESS_CONTRCL => readable
+2827.135945 €492 660 AFI Verbose
+2927.135926 6452 660 np1 Info GCReadPort (PORT_HANDLE hPort = 7, uint64_t iAddress = 0x0000000000004020, void *pBuffer, size_t *piSize -> )
+2927.135946 6452 660 2p1 Debug  Port handle 7: DEVICE_ACCESS_CONTROL => readable
+2927.135947 €492 660 API Verbose

e When you hover over the left columns, a short description of the kind related to the message

appears in the Tooltip area.

e When you hover over the Trace column, the full text of the message body appears in the
Tooltip area.

[7

NOTE
Items still displayed in the message list, but no longer available in the ring
buffer, appear dimmed in the list (except the content of the Trace column,
whose color is defined in the Memento rules).

Data Fields

The following data fields can be displayed in the message list:

e Seq: the sequential number assigned by Memento when a message is entering the Memento

ring buffer

e Time: the time attribute value assigned by the message producer and expressed in seconds
with 6 decimals

o Delta: the time offset relative to the user-defined time reference; the value is expressed in
seconds with 6 decimals

e PID: the Process ID attribute value optionally assigned by the message producer

| comm...
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e TID: the Thread ID attribute value optionally assigned by the message producer

e Card: the Card ID attribute value optionally assigned by the message producer

e Connector: the Connector ID attribute value optionally assigned by the message producer
e Stream: the Stream ID value optionally assigned by the message producer

e Level: the Level attribute value assigned by the message producer

e Kind: the Kind attribute value assigned by the message producer

e Trace: the text of the message body

e Comment; a user-editable data field

Display or hide a column

e To display a field, right-click the column headers and select the field you want to display.
e To hide a field, right-click the column headers and deselect the field you want to hide.

You cannot modify the column order.

Change the font size

e Toincrease the font size in the message list, click the message list, then click Z.

e To decrease the font size in the message list, click the message list, then click SHIFT + Z.

Context menu

The following context menu appears when right-clicking in the message list:

Auto resize Trace column

Set time reference

Inject current time trace

Copy
Copy all

Copy same as

Copy similar to

Bookmarks >
Plot »
Show analyzer

Auto-Follow plot

Show keyboard shortcuts

e Auto resize Trace column: resizes automatically the Trace column to best fit the content.
Select to enable the option: a check mark is displayed in front of the menu option.

e Settime reference: sets the time reference +0:000000 on the current message in the Delta
field. See "Using Time Information" on page 76.

e Inject current time trace: injects a message containing the UTC time and date in the ring buffer.
See "Using Time Information" on page 76.
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e Copy: copies the content of the selected message to the clipboard. See "Back up Memento
Traces" on page 65.

e Copy all: copies the content of all messages to the clipboard. See "Back up Memento Traces"
on page 65.

e Copy same as: copies to the clipboard the content of all messages with the same description
in the Trace column as the currently selected message. See "Back up Memento Traces" on
page 65.

e Copy similar to: copies to the clipboard the content of all messages with a similar description
in the Trace column as the currently selected message. See "Back up Memento Traces" on
page 65.

e Bookmarks: gives access to the controls related to bookmarks (create, clear, jump to, select).
See "Define Bookmarks" on page 31.

e Plot: allows you to represent selected messages in the message plot. See "Browse Through
Traces" on page 25.

e Open Analyzer: allows you to extract the Analyzer traces to the viewer buffer and give access
to the Analyzer controls in the Memento GUI. See "Activate the Analyzer" on page 33.

e Analyze: gives access to Analyzer controls from the message list when the Analyzer
functionality is enabled and configured. See "Use Analyzer Tools" on page 41.

e Auto-Follow plot: shifts the message plot, without changing the zoom, to show the time frame
where the selected message is displayed. See "Search for and Find back Traces" on page 28.

e Show keyboard shortcuts: opens the summary page with the list of keyboard shortcuts
available in the Memento GUI.

3.7. Status Bar

‘Tra:a;: total 19887, history 19887 Delta time: 77.265427 Status: Runnin: g

The Status Bar area of the Memento application displays:

e Traces: total # The total number of Memento traces that have been extracted to the viewer
buffer.

e Traces: history # The number of Memento traces that are currently available in the viewer
buffer.

e Deltatime The time difference between the selected message and the time reference. This
value is also displayed in the delta column of the message list.

e Status The operating status - Running or Suspended - of the Memento application.
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4. Monitoring the Activity

You can monitor traces in real-time as they are added to the ring buffer, check older traces still
available in the ring buffer or analyze traces dumped to a log file.

The actions described in this chapter are also valid for message traces and Analyzer traces.
Otherwise, this is specified. See chapter "Analyzing Events" on page 33 for analyzing operations
specific to Analyzer traces.

4.1. Monitor the Activity in Real Time

Default behavior

When you open the Memento application, the traces currently being added to the ring buffer
automatically start being extracted to the viewer buffer.

By default, the Memento traces are therefore instantly made available in the Memento
application and the most recent traces are displayed at the bottom of the message list.

This allows you to directly monitor the system activity in real time in the Memento application.

You can change the default behavior using the options Follow/Following and Pause/Run available
in the Control bar.

( N
NOTE

The operations of injecting traces to the ring buffer, extracting traces to the
viewer buffer and displaying traces in the Memento application are based on
default filtering criteria applied to traces. These filters are configurable at
these three levels: injection, extraction and display. To change the filtering
criteria, refer to section "Configuring Trace Extraction and Display" on page
45,

- J

Enable/Disable trace update

e Set the Run/Pause button to Pause (enabled) to continuously extract the messages from the
ring buffer into the viewer buffer: the message list is dynamically updated with new
messages and the time is running out in the activity plot. This is the default behavior, which
allows real time activity monitoring.

e Set the Run/Pause button to Run (disabled) to stop extracting messages from the ring buffer
and filling in the viewer buffer: the message list is not updated and the time is stopped in the
activity plot.
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Display automatically most recent traces

e Set the Follow/Following button to Following (enabled) when you want Memento to
automatically scroll to the end of the message list and always display the most recent traces.

This is the default behavior. As soon as you click a trace in the message list, the option
however shifts to Follow to keep the focus on the selected message.

e Set the Follow/Following button to Follow (disabled) when you do not want to change the
current display of messages.

To display the most recent messages in this mode, you need to scroll manually to the end of
the message list.

This option is mainly relevant when the Run/Pause option is set to Run.

4.2. Monitor Earlier Stored Activity

Introduction

If a problem occurred some minutes ago in the production process, you can rapidly find back
the related traces and load them in the Memento application, as long as the traces are available
in the ring buffer. The Go Back function makes it possible to define the traces you want to
extract to the viewer buffer and load into the Memento application.

NOTE

The extraction process by the viewer buffer and the actual display in the
Memento application are based on the defined filtering criteria. If you want
to extract and display more or less information in the Memento application
when you perform a Go Back, you need to change the Read filters and/or
Memento Rules before you perform a Go Back action. See section
"Configuring Trace Extraction and Display" on page 45.
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Go back to earlier stored traces

cRresys

1. Click the Go Back button.

The Go Back dialog box appears:

Go Back — >
Go Back Setup

Rewind: [As far as possiblc e
Boot session: IEI

Options
Limit amount of extracted traces:

Apply StopGoBack rules:

Ok ‘ Cancel

Al
Yes -

Continue

bj

2. In the Go Back Setup area, configure the Go Back action:
o In the Rewind field, select how far in time or in positions from the most recent trace (in

the specified boot session) you want to rewind in the ring buffer.

o In the Boot session field, select the Memento driver boot session (0=current, 1= previous,
...) that you want to extract traces from. This is only relevant with a Windows OS.

See Go Back setup options for more detailed information.

3. In the Go Back Options area, specify options for the Go Back action:

o In the Limit amount of extracted traces field, select the number of traces (in the specified

boot session) you want to view starting from the rewound position.

The trace extraction will be paused each time the defined amount of traces has been

extracted.

o In the Apply StopGoBack rules, select Yes if you want the StopGoBack rules to pause the

trace extraction.

The trace extraction will be paused each time a trace matches the settings defined in a

StopGoBack rule.
4. Click OK.

The message list is cleared, then filled in with the traces matching the Go Back definition.

If a Go Back option has been defined, the trace extraction is paused when one of the options is
met. Click Run to resume the trace extraction.

The message plot display is not modified. To get the overview on all traces extracted with the
Go Back option in the message plot, right-click in the message list and select Plot > All.
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If you go back as far as possible in the ring buffer and extract all traces to the
viewer buffer, all extracted traces might not be displayed in the message list
as the number of displayed traces depends on the maximum capacity of the

viewer buffer.

The data extraction mechanism indeed fills in the viewer buffer until the

most recent traces are displayed. As a consequence, the oldest messages
will not be displayed in the message list if the number of messages to be
displayed exceeds the maximum capacity of the viewer buffer.

It is therefore recommended to limit the amount of extracted traces if you
want to be sure to display the messages from the rewound position.

Go Back setup and options

Memento application - GUI mode - Go Back dialog box

Rewind

Options
Limit amount of extracted traces:

Apply StopGoBack rules:

Ok ‘ Cancel

Go Back — >
Go Back Setup

Rewind: s far as possibleJig
Boot session: 0 -

A
Yez =

Continue

bj

This determines the time frame or number of positions to rewind in the Memento ring buffer
before starting to extract data.

Possible values are:

Value

Description

As far as possible

Rewind as far as possible within the data of the specified boot

session.

1ms, 1s, 10s, 1m,
1m30s, 10m, 1h

Rewind 1 ms, 1s, etc. in time compared to the most recent trace in

the specified boot session.

10, 100, 1000, 10000,
100000

Rewind 10, 100, etc. positions compared to the most recent trace in

the specified boot session.

Boot session

This specifies the number of boot sessions to rewind to. This is only relevant in Windows.
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Possible values are:

Value  Description

0 Current boot session. Default setting.

Previous boot sessions, 1 being the more recent session (if still available in the ring

12,3 puffen.

Limit amount of extracted traces

This option specifies how many messages are to be extracted starting from the rewound
position in the Memento ring buffer.

By default, all traces of the specified boot session are extracted.

Apply StopGoBack rules

This option specifies whether StopGoBack rules are taken into account as conditions to pause
the trace extraction.

To be used in the Go Back option, the StopGoBack rule has to be defined and enabled in the
Memento Rules window (See section "Trigger Actions on Traces" on page 52).

Continue button

It allows you to change one of the options and to continue the trace extraction without clearing
all messages in the message list.
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4.3. Load Traces from a Dump File

Introduction

If you have previously saved the traces added to the ring buffer to a dump file, you can load the
dump file in the Memento application to view the saved data.

See the section "Back up Memento Traces" on page 65 for detailed information on saving traces
to a dump file.

Load traces from a dump file

e Double-click the dump file and it will directly open in a new instance of the Memento
application.

NOTE

You can open a dump file that data is still being added to. In this case, the
Memento application will load the data available in the dump file when it
was opened. The data is not automatically refreshed. To view the most
recent data from the dump file, close the Memento application and reopen
the dump file in a new instance of the Memento application.
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5. Looking for Traces

This chapter describes all standard actions that will help you find back the traces relevant for
your investigations:

e focus on events in a specific time frame in the plot areas
e find back information in the message list based on a search

e adding bookmarks in the message list to easily identify given traces, etc.

5.1. Overview of Trace Display in Plots

Each trace (standard trace or Analyzer trace) in the message list is represented visually
respectively in the message plot or Analyzer plot.

Standard trace display in the message plot

e The symbol = represents one or more traces in the message plot depending on the applied
zoom.

e The symbols are displayed on horizontal lines. Each line corresponds to a verbosity level.

e The first line at the bottom represents the lowest verbosity level (verbose), the second line
represents the next verbosity level (debug), and so on up to the highest verbosity level
(critical).

e The symbols inherit the colors defined in the (Display) rules for the given verbosity level: this
corresponds to the font color in the message list.

See also "Message Plot" on page 13.

Analyzer trace display in the Analyzer plot

e Starttrace: the waveform moving up one level indicates the corresponding process starts.

e Resettrace: the waveform moving down one level indicates the corresponding process
stops.

e Countertrace: a vertical line, an empty rectangle or a value (depending on the zoom level)
displayed on a waveform means a value is issued in the corresponding process.
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See also "Analyzer Plot" on page 14.

5.2. Browse Through Traces

Zoom in the plot

This procedure allows you to zoom in and out by changing the timescale in the message plot (or
Analyzer plot) in a general way.

1. Hover over the requested position in the message plot.
2. Rotate the mouse wheel up to zoom in and down to zoom out.

To zoom faster, press CTRL and rotate the mouse wheel as described in step 2.

Zoom on a specific portion of the plot

This procedure allows you to zoom in onto a specific portion of the message plot (or Analyzer
plot).

1. On the message plot, right-click the position you will start zooming from.
2. Dragthe mouse to the right up to the position you want to stop zooming.

As you drag, a red rectangle is displayed showing the portion to be zoomed on:

~

When you release the mouse, the zoomed portion is stretched to the whole plot area.

Repeat this action to dig more precisely in the message plot or Analyzer plot.

Shift the time frame in the plot

When traces are available on the left or right of the time frame displayed in the message plot, a

red ?rrow appears on the left border. or right border. of the message plot (or Analyzer
plot).
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e In the message plot, click and drag to the left or right to change the displayed time frame
keeping the same zoom level.

Move up and down in the message list

Move rapidly up and down in the message list with the standard shortcut keys:

e PAGE UP to move up in the message list and display the previous set of messages.

e PAGE DOWN to move down in the message list and display the next set of messages.
e HOME or G to move to the top of the message list.

e END to move to the bottom of the message list.

e SHIFT + G to move to the bottom of the message list and set the Follow/Following option to
Following.

Display the plot for a set of traces

You can generate a plot corresponding to all traces of the current boot session, to the traces
displayed in the message list or to a selection of traces.

The procedures below describe the various ways to plot message traces in the message plot.
Similar controls are available to build graphs of Analyzer traces in the Analyzer plot.

Plot all traces of the current boot session

e Right-click in the message list and select Plot > All from the context menu.

The number of traces displayed is limited to the maximum capacity of the viewer buffer.
Plot the traces displayed in the message list

e Right-click in the message list and select Plot > View from the context menu.

Plot traces selected in the message list

1. Select the first message in the message list.

2. Scroll to the last message of your selection.

3. Simultaneously press SHIFT and click the last message to select all messages between the
first and the last.

4. Right-click the message list and select Plot > Selection from the context menu.
Plot traces between a selected message and a bookmark

This option is only available when at least one bookmark has been defined. See "Define
Bookmarks" on page 31.

1. Click the message that you want to view the plot from/to.

2. Right-click, then select Plot > From/To bookmark and the requested bookmark name.
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~  Auto resize Trace column

Set time reference

Inject current time trace

Copy
Copy all

Copy same as

Copy similar to

Bookmarks
Plot

Open analyzer

+  Auto-Follow plot

+  Show keyboard shortcuts

Selection

From/To bookmark
Between bookmarks
View

All

Plot traces between two bookmarks

bkm 0
bkm 1
bkm 2
bkm 3
bkm 4
bkm 3
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This option is only available when two bookmarks have been defined. See "Define Bookmarks"

on page 31.

e Right-click in the message list, select Plot > Between bookmark and the boundary bookmarks
in the subentries of the context menu.

~  Auto resize Trace column

Set time reference

Inject current time trace

Copy
Copy all

Copy same as

Copy similar to

Bookmarks
Plot Selection
Open analyzer From/To bockmark >
Between bookmarks » bkm 0 and > bkm 0
| /uto-Follow plot View bkm 1 and > bkm 1
~  Show keyboard shortcuts All bkm 2 and ¥ bkrm 2
bkm 3 and > bkm 3
bkm 4 and > bkm 4
bkm 5 and ¥ bkm 5
NOTE

To build graphs of Analyzer traces, proceed similarly using the Analyze item

in the context menu of the message list, and the corresponding subitem.
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5.3. Search for and Find back Traces

Search for traces based on the Trace field content

To search for messages including a specific text string in the Trace column, use the Search field
at the top of the main window:

[~ Aa [ RE [Search: - Config... Follow Run Clear Go Back... =
Jsarn B | | | |

Time: 3243.675429s, Delta: +369.963423s
Trace: D50ueueBuffer(DS_HANDLE hDataStream = 9, BUFFER_HANDLE hBuffer = 17)

Ced-Click te formn #n thic frnre

Trace |f\
Info GenapiFetFloat (D5 HAWDLE hDataStream = 8, const char *sFeatur]

+121.252154 10256 17540 APT

1. Click the Search field or press / on the keyboard to enable the field.
2. In the Search field, type the requested text string.
See "Advanced queries" on page 28 for more information on the available operators.

3. When applicable, select one of the search options:
o Aa check box for case-sensitive searches.
o RE check box for searches based on Perl-like regular expressions.

4. To search for the entered string:
o press F3 to search down.
o press SHIFT + F3to search up.

Advanced queries

Using the following operators in the Search field, you can build queries to perform advanced
searches on the various columns of the message list:

e Prefix the search query with the \ character. Do not include a space after the backslash.
e Use one of the following operators with double-quoted strings: =, |=.
e Use one of the following operators with numerical values: =, |=,>, <, >= <=

e Combine expressions with the logical operators: && or || adding parentheses around the
expressions.

e Reverse an expression by adding ! in front of the expression.

Examples

e \(delta>5 && trace="flush") && (producer!="recorder")

e \l(producer="recorder" || producer="eGrabber")
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Search for traces having identical or similar content

When you identify a specific trace and want to find back other traces having the same or a
similar description in the Trace field, or the same kind, level, PID or TID, you can perform such
searches directly in the message list, without using the Search field.

By traces having a similar description in the Trace field, we mean traces having the same fixed
frame but possibly different values for the optional arguments.

1. In the message list, identify the message having the content (value in Trace, Kind, Level, PID
or TID field) you want to search for.

2. In this message, click the field with the value you want to search for.

3. Use the following keyboard or keyboard combinations:

In order to ... Proceed as follows:

Search downwards for traces having the same content  Press J (or * in the numeric pad).

Press SHIFT + J (or SHIFT + * in the

Search upwards for traces having the same content -
numeric pad).

Search downwards for traces having a similar content  Press S (or - in the numeric pad).

Press SHIFT + S/ (or SHIFT + - in the

Search upwards for traces having a similar content .
numeric pad).

Copy a trace from the message list to the Search field Select the trace in the message list

and press Y.
Repeat the last search you performed in the message e Press F3 or Nto search down in
list. the message list.
This does not necessarily correspond to the last search e Press SHIFT+F3 or SHIFT+N to
criteria entered in the Search field. search up in the message list.

Find back bookmarked traces

When you have assigned bookmarks to traces, you can easily find such traces back in one of the
following ways. See "Define Bookmarks" on page 31.

The bookmark names are specified in the Comment column.
e In the message list, right-click and select Bookmarks > Jump toand the bookmark name.

e In the Search field, type the bookmark name or part of it and press F3.

Find back a trace from the message list in the plot

To directly find back, in the message plot (or Analyzer plot), a trace you have identified in the
message list, proceed as follows:

1. In the message list, right-click and enable the option Auto-Follow plot.
2. In the message list, click the trace you want to find back in the plot.

The current position marker (yellow vertical bar) is displayed in the plot area to represent the
position of the selected message.

If necessary, the message plot shifts to show the relevant time frame.
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D NOTE

Enabling the Auto-Follow option might degrade the performances when
many traces are generated. It is therefore recommended to disable the
option when you do not need it.

Find back a trace from the plot in the message list

To directly find back, in the message list, a trace you have identified in the message plot (or
Analyzer plot), proceed as follows:

e Press CTRL and click on the trace symbol in the plot area.

In the message list, the Trace field of the corresponding trace is displayed in a black frame:

+0.000240 83787¢0 Profiling  Info [[cxE] DEC counter: +1 / 26297253 us, time in DEC: +30 us [30 us, 30 us], Cime with IRQL Masksd: +9% us

Copy a tooltip to the clipboard

The Tooltip area displays the information corresponding to the mouse cursor position. It is thus
dynamically updated.

1. Position the mouse cursor on the requested trace in the message plot.
The corresponding tooltip is displayed in the Tooltip area.

2. Press SHIFT to freeze the tooltip message in the Tooltip area.

3. Drag the mouse cursor to select the tooltip text.

4. Right-click and select Copy from the context menu.

e I

Redo

Cut

Copy
Paste
Delete

Select All

The tooltip text has been added to the clipboard. You can paste it wherever you want.



Memento @euresys

a TKH Vision by

5.4, Define Bookmarks

Bookmark Use

Once bookmarks are created, they will help you perform a series of actions:
e Find bookmarked traces

e Plot traces using bookmarks as start and/or end boundaries

e Create a dump file of traces between bookmarks

e Display time interval between two bookmarks

etc

@ WARNING

Bookmarks are lost when you close the Memento application.

Add a bookmark

1. In the message list, select the trace you want to add a bookmark to.

2. Do one of the following actions:
o Right-click and select Bookmarks > Toggle.
o Press F4.

In the message list:

e The bookmarked trace is highlighted on a light blue background.
e A default bookmark name is added in the Comment column for this trace.

The default bookmark name bkm X where X is a incremented number starting from 0

+89.996452 8608 9624 API Info bkm 1

In the message plot:

e The bookmarked trace is represented by a blue marker with the default bookmark name.
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Clear bookmarks

Clearing a bookmark disables the bookmark so that it is no longer highlighted in the message
list nor displayed in the message plot. It is no longer available in the various options where you
can use them.

Clearing a bookmark does not remove the default bookmark name in the Comment column. You
need to clear the name manually in the Comment column.

To clear all bookmarks

¢ Right-click in the message list and select Bookmarks > Clear all.

To clear a single bookmark

1. Select Bookmarks > Jump and the bookmark name.

2. Press F4 or select Bookmarks > Toggle.

Edit the bookmark name

When created, the Memento application assigns a default name to each bookmark: bkm
followed by an incremented number.

To edit the bookmark name, proceed as follows:

e In the message list, click the bookmark name in the Comment column and type the
requested name.
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6. Analyzing Events

This chapter explains how to enable, configure and use the Analyzer functionality in the
Memento application.

6.1. Activate the Analyzer

Introduction

Thanks to the Analyzer functionality, events and state changes in the various steps of the digital
image acquisition process can be represented as waveforms in a specific Analyzer plot, below
the message plot.

By default, the Analyzer functionality is not active in the Memento application. You need to
enable and configure it as described below:

1. Click the Menu button il and select Enable analyzer to allow the extraction of the Analyzer
traces to the viewer buffer.

2. Click the Menu button il and select Show analyzer to open the Analyzer Configurator
window and the Analyzer plot in the main window.

3. In the Analyzer Configurator, define which Analyzer waveforms you want to display in the
Memento application. See "Configure Traces for Analysis" on page 36.

When the Analyzer has been configured, the selected Analyzer waveforms appear in the
Analyzer plot.
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6.2. Overview of the Analyzer Configurator

The Analyzer Configurator allows you to select the types of events or state changes you want to
display as Analyzer waveforms in the Analyzer plot.

See "Configure Traces for Analysis" on page 36 for more information on the configuration.

Click the Menu button ﬂ in the Control bar and select Open Analyzer to open the Analyzer
Configurator window. This option is only available if you have previously selected Enable

Analyzer via the Menu button.

[@ Analyzer Configurator - o X

®-FI|E Edit View Analyze
@- Profiles |Advanced|

Kinds

©5
.ﬁcquisitinn
[¥] Hardware

@_ Contexts

&4 Coaxlink Card:0 Connector:A Stream:0

Acquisition>q.Pending Coaxlink Card:0 Connector:A Strearn:()
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(1) Menu bar

The Menu bar includes the following menus and menu items:

Menu (and Menu Useitto ...

item)
File > . . .

save or load an Analyzer session, which includes the Analyzer settings, the
Save / Load . .

. bookmarks and the current plot view settings.

analyzer session
Edit > . . . :

select or deselect all trace kinds and contexts available in the Profiles or
Select all /

Advanced tab.
Deselect all
Edit >
Reassign reassign the default set of colors to the displayed waveforms.
automatic colors
Analyze > .
All plot all Analyzer traces in the Analyzer plot.
Analyze > . . C .
View plot the Analyzer traces displayed in the message list with Analyze > View.
Analy;e ” plot the Analyzer traces selected in the message list Analyze > Selection.
Selection

The Analyze menu corresponds to the Analyze > All / View / Selection available in the context
menu of the message list.

(2) Tabs

e The Profiles tab allows you to select which Analyzer waveforms you want to be available in
the Memento application.

e The Advanced tab allows you to refine the selection of the Analyzer waveforms, change the
name or the color of the waveforms in the Analyzer plot.

This tab is not described as the Profiles tab provides enough selection criteria.

(3) Profile tab - Kinds area

The Kinds area allows you to perform a first selection, based on the kinds, of the Analyzer
waveforms you want to display in the Analyzer plot.

The kinds provide a classification based on the nature or origin of the messages - for example
messages related to the firmware, to an API, to the communication between components, etc.

The Kinds area displays only the kinds having Analyzer traces available in the ring buffer.

(4) Profile tab - Contexts area

The Contexts area allows you to perform a more refined selection of the Analyzer waveforms you
want to display in Analyzer plot.
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For each kind selected in the Kinds area, the selection in the Contexts area allows you to define
the driver, card, connector (and possibly stream) you want to display the Analyzer waveforms
for in the Analyzer plot.

(5) Profile tab - Waveforms area

The Waveforms area show the Analyzer waveforms resulting from the selection in the Kinds and
Contexts areas.

In this area, you can further remove and reorder the waveforms individually.

These waveforms will appear in the Analyzer plot.

6.3. Configure Traces for Analysis

You can configure which Analyzer waveforms you want to display in the Analyzer plot using the
Analyzer Configurator.

See the section "Overview of the Analyzer Configurator" on page 34 for a general description.

@ WARNING

Once you have configured the waveforms you want to view in the Memento
application, you need to keep the Analyzer Configurator window open for
the Analyzer plot to be displayed in the main window.

Accessing the Analyzer Configurator

1. If you have not enabled the Analyzer yet, click the Menu button ﬂ and select Enable
analyzer.

Open Memento durnp...

Clear search history
Clear all user preferences

Clear analyzer preferences
Dump memento data to file...
Inject current tirne trace
Reload trace definition
Enable analyzer

About...

2. From the Menu button, select the Show Analyzer control.
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~  Enable analyzer

Show analyzer

The Analyzer Configurator window opens.

Select the Analyzer waveforms

To select the Analyzer waveforms you want to display in the Analyzer plot, proceed as follows in
the Analyzer Configurator:

1. In the Kinds area, select the kinds that you want Analyzer traces to be available for in the
Memento application.

2. In the Kinds area, highlight a selected kind to show the available contexts (producers, cards,
connectors and streams).

3. In the Contexts area, select the waveforms you want to be available for this kind.

All Analyzer waveforms corresponding to the selected kinds and contexts are displayed in the
Waveforms area at the bottom of the Analyzer Configurator window.

Analyzer Configurator — | X
Edit View Analyze

Profiles ‘ Advanced
Kinds
DMA

Acquisition
{4 Hardware

Contexts

#8 Coaxlink Card:0 Connector:A Stream:0

Pattl Card:1 Connector:A Stream:1
E] Pattl Card:0 Connector:A Stream:0

Hardware> Readout Pattl Card:1 Connector:A Stream:1

ion>q.Pending Coaxlink Card:0 Connector:A Stream:0
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To delete an individual waveform directly in the Waveforms area below,
click the waveform and press Delete.

Reorder Analyzer waveforms

The order of the waveforms in the Analyzer plot corresponds to the order defined in the
Waveforms area at the bottom of the Analyzer Configurator window.

e To change the position of a waveform, click the waveform name in the Waveforms area and
drag it to the requested position.

6.4. Modify the Analyzer Trace Display

Default display of Analyzer waveforms

The default display settings for the Analyzer plot are the following ones:

The timescale views on the Analyzer plot and the message plot are not tied to each other.

The name of the waveforms is displayed on the left of the Analyzer plot.

The counter values in the Analyzer plot are displayed in the decimal numbering system.

DMA 0:zRA:z0
isterValue O:A:

header SocurceTag 0O:4:

In the Analyze plot, you can use SHIFT + double click on a waveform to
highlight the corresponding profile in Analyzer Configuration window.
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Modify the default display settings

Parameters are available to modify the default display of Analyzer waveforms. To access most
of these parameters, right-clicking in the message plot to open the context menu. The relevant
parameters are highlighted in the screenshot below:

Auto resize Trace column

Set time reference

Inject current time trace

Copy
Copy all

Copy same as

Copy similar to
Bookmarks ¥
Plot ¥

~  Show analyzer

Analyze ¥ Selection
Auto-Follow plot View
All

Show keyboard shortcuts
Plot current analyze view

Analyze current plot view

~  Link views
~  Show plot info

Show hexadecimal values

Hide the waveform name

By default, the name of the waveforms is displayed on the left of the Analyzer plot.

To hide the waveform name in the Analyzer plot and show the plot information on the full
timescale length:

e Right-click the message list and select Analyze > Show plot info from the context menu.

The name of the waveforms is now hidden. You can reactivate it in the same way.

Display values in hexadecimal notation

By default, the counter values on waveforms are displayed using the decimal notation.
To display the counter values in hexadecimal notation:

e Right-click the message list and select Analyze > Show hexadecimal values from the context
menu.

Use an alias for the waveform name

To customize the waveform names in the Analyzer plot, proceed as follows:

1. In the Analyzer Configuration window, select the Advanced tab.
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2. Identify the waveform you want to assign an alias to.

3. Click the cell to the right of the Alias field and type the requested alias.

=l Coaxlink Card:0 Connector:A Stream:0 [+
Color [ (120,142,112

The waveform name will be adapted in the Analyzer plot.

Modify the color of a waveform

1. In the Analyzer Configuration window, select the Advanced tab.

2. ldentify the waveform you want to change the color of.
3. Click the More button J to the right of the field displaying the color.

B Acquisition>g.Input

[=I Coaxlink Card:0 Connector:& Stream:0 [
Color ] (80142112 4:13
Alias Input queue

The Color dialog box opens

4. In the Color window, select a color in the basic colors or type the RGB / HSL color
coordinates and click OK to validate.

The waveform color is automatically adapted in the Analyzer plot.

Change the height of the Analyzer plot pane

You can modify the height of the Analyzer plot, which will also modify accordingly the font size
of the text displayed.

1. Click in the Analyzer plot pane.

2. Do one of the following actions:
o To increase the height of the pane, click Z.
o To decrease the height of the pane, click SHIFT + Z.

Alternatively, you can use the key combinations CTRL + Num + and CTRL + Num - (on numeric
keypad).
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6.5. Use Analyzer Tools

Available standard tools

Most actions available for message traces in the message plot are also available for Analyzer
traces in the Analyzer plot. This is explicitly specified in the relevant procedures:

e "Browse Through Traces" on page 25
e "Using Time Information" on page 76

When the description of Analyzer traces is displayed in the message list (see "Configure Traces
for Analysis" on page 36), you can search for these traces as described in the section "Search for
and Find back Traces" on page 28.

Display the Analyzer graph for a set of traces

You can build a graph of Analyzer traces in the same way as you can plot the message traces.
Similar controls are available, as well as controls that imply the use of bookmarks.

You can access the various controls for building Analyzer graphs in the context menu of the
message list, from the Analyze menu.

These controls are highlighted in the screenshot below:

Auto resize Trace column

Selection
Selimees s From/To bockmark ¥
Inject current time trace Between bookmarks .
Copy View
Copy all All

Copy same as Plot current analyze view

Copy similar to Analyze current plot view

Bookmarks ¥

Measure between bookmarks ¥
— > v Link views
~  Show analyzer ~  Show plot info
Analyze > Show hexadecimal values

Auto-Follow plot

Show keyboard shortcuts

See the section "Display the plot for a set of traces" on page 26 for procedures on how to use
these controls.
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Plot current analyze view

When the Link views option is disabled and both message plot and Analyzer plot show different
time frames, you can rapidly plot the message traces in the message plot based on the time
frame displayed in the Analyzer plot:

e Right-click in the message list and select Analyze > Plot current analyze view from the context
menu.

Example

In the initial situation, the Analyzer plot covers a different time frame than the message plot:

adex.SouzceTag 0:A:0E

After selecting the option to plot the current analyze view, Memento builds a plot in the
message plot that spans over the time frame displayed in the Analyzer plot:

2

q.Output 0: [
Bic. Fending 0:2:0 NN

DMA D:A:0
RegisterValue 0:A:

R header . SourceTag 0:
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Analyze current plot view

When the Link views option is disabled and both message plot and Analyzer plot show different
time frames, you can rapidly build waveforms in the Analyzer plot based on the time frame
displayed in the message plot:

e Right-click in the message list and select Analyze > Analyze current plot view from the context
menu.

Example

In the initial situation, the Analyzer plot covers a different time frame than the message plot:

q_Unqueued 0:A:0
. Input 0:A:0
q.Output 0:A:0

q.Pending 0:A:0
TMA 0:A:0

RegisterValue 0:A:

header.ScurceTag 0:A:0

After selecting the parameter to build a graph of the current plot view, Memento spans the
waveforms in the Analyzer plot over the time frame displayed in the message plot:
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Measure the events between bookmarks

You can measure the number and frequency of events over a given time frame for all displayed
waveforms:

1. Set two bookmarks to identify the time frame that you want to analyze the events in:

a. Press CTRL and click on an event in the Analyzer plot to set the position for a new
bookmark.

b. Press F4 to add the bookmark.
c. Repeat both previous actions to define a second bookmark.
2. Right-click in the message list to open the context menu.

3. Select Analyze > Measure between bookmarks as well as the boundary bookmarks in the
context menu.

The number and the frequency of events over the defined time frame are displayed on the right
hand of the Analyzer plot, as highlighted in the screenshot below:

A r o 1

q_Pending 0:A:0
IDM.A O:A:D—E—E i
RegisterValue 0:A: —

SR  —————— R S — i f——— i — i ——

Call up the previous trace

To call up the previous trace on a waveform and display it at the cursor position in the Analyzer
plot:

e Position the mouse cursor on a given waveform around the position you are searching for
events and middle-click the mouse.

The waveform will shift and display the previous trace on that waveform.
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7. Configuring Trace Extraction and

Display

This chapter explains how you can modify, at the three levels specified below, the default
settings for filtering and/or displaying the traces :

e "Filter Traces for the Memento Storage" on page 45
e "Filter Traces for the Memento Application" on page 48

e "Trigger Actions on Traces" on page 52

7.1. Filter Traces for the Memento Storage

Use of write filters

In the Memento application, you use write filters to filter the traces to be added to the ring
buffer (Memento storage).

Defining a write filter allows you to specify that all traces of a given kind and with at least a
given verbosity level shall be written to the ring buffer.

The messages that don't meet the write filter criteria are not written to the ring buffer. You will
therefore never be able to view such messages in the Memento application.

Without opening the Memento application, you can quickly configure of the ring buffer by
applying predefined configuration profiles. See section "Setting up the Driver" in the Getting
Started guide (D602).

NOTE
When you change the write filters, the new filtering criteria are applied to all
future messages added to the ring buffer.
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Access the write filters

From the Memento main window, select M in the Control bar, then Write Filters in the
Memento Configuration window.

Memento Configuration — %
File Edit

Memento Flow
’7Memento producers = Write Filters | - Memento storage (ring) = Read Filters | = Memento application = -* Action

See section "Write Filters" in the Getting Started guide (D602) for a detailed description of the
write filters.

The Write Filters dialog box opens. Right-clicking gives access to all controls in the context menu:

Euresys Memento Confi... - O *

Kind | Level J Analyzer |

API Verbose True

CoaXPress Debug -

DPC Set level >

GenApi

v

OCTL Analyzer

IRQ Add kind >

Memento )

Pnp Remove kind

Profiling .

>
(Default] Load profile
s Y

NOTE
You can modify the write filters when the Memento application is receiving a
live feed.

You cannot modify the write filters when a dump file is open, even if the
dump file is being fed with new traces from the ring buffer.
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Example of write filters

Euresys Memento Configuration - O *
Kind | Level | Analyzer
CoaXPress Debug True
DPC Info True
GenApi Debug False
I0CTL Info True
IRQ Info True
Memento Info True
PnP Debug  True
Profiling MNotice  True
[Default] Verbose True

Looking at the screenshot above, you can see that:

e The CoaxPress filter is defined with the verbosity level Debug, for example: all messages
linked to the CoaxPress kind and having at least the Debug verbosity (that is Debug, Info,
Notice, Warning, Error, Critical) will be added to the ring buffer. For this kind, the Verbose
messages will not be added to the ring buffer.

e The Default filter applies to all kinds not explicitly defined in the Write Filters dialog box. In
this case, all messages will be added for these kinds whatever their verbosity level, as the
defined verbosity level is Verbose (highest verbosity).

Change the verbosity level for a kind

Kind available in the list

1. Right-click the requested kind to access the context menu.

2. Select Setlevel and the requested verbosity level.

Kind not available in the list

This means the default verbosity level is applied to this kind:
1. Right-click to access the context menu.
2. Select Add kind and the requested kind from the context menu.

3. Right-click the kind, then select Set level and the requested verbosity level from the context
menu.

Reset a kind to the default verbosity level

1. Right-click the requested kind to access the context menu.

2. Select Remove kind from the context menu.
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Exclude Analyzer traces from the ring buffer

By default, the Analyzer traces are added to the ring buffer.

To prevent them from being added, do the following:

1. Click the kind corresponding to the Analyzer traces you want to exclude from the ring buffer.
2. Right-click and deselect Analyzer from the contextual menu.

The Analyzer setting for this row is now set to False and the Analyzer traces will not be added to
the ring buffer.

Apply a configuration profile

The configuration profiles allow you to apply a predefined configuration to write filters.

For more information on configuration profiles, see "Use Predefined Configuration Profiles" on
page 64.

To change the configuration profile, do the following:
1. Right-click to access the context menu.
2. Select Load profile and the requested profile.

The traces will be added to the ring buffer based on the loaded configuration profile.

7.2. Filter Traces for the Memento Application

Use of Read filters

In the Memento application, you use read filters to define the traces extracted from the ring
buffer or dump file, and added to the viewer buffer.

The traces sent to the viewer buffer are displayed by default in the Memento application.

[ o

When you change the read filters in the Memento application, the new filters
are applied to read subsequent traces.

If you want the same read filters to be applied to all messages in the viewer
buffer, first clear the viewer buffer using the Clear button, then perform a Go
Back to regenerate the viewer buffer.

Access the read filters

From the Memento main window, select M in the Control bar, then Read Filters in the
Memento Configuration window.
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Memento Configuration — X
File Edit

Memento Flow

Memento producers = Write Filters | = Memento storage (ring) = Read Filters | = Memento application = =» Action

The Read Filters dialog box opens. Right-clicking the Verbosity pane or the Context pane gives
access to the relevant controls for the pane.

See section "Read Filters" in the Getting Started guide (D602) for a detailed description of the
read filters.

Example of read filters

Euresys Memento Read Fil..  — O *
Verbosity

Kind | Level | Analyzer

CoaXPress Debug  True

DPC Infa True

Genfpi Debug  True

10CTL Infa True

IRC Infa True

Memento Infa True

PnP Debug  True

Profiling Motice  True

[Default] Verbose True

Context

Field Filter

Producer Is neither Multicam nor Grablink
Card *

Connector *

Stream *

£ >

First filtering level based on the verbosity level:
Are logged into the viewer buffer:

e all traces without a kind-specific rule whatever the verbosity level, as Verbose is the level
with the highest verbosity (or least critical level).

e all traces with a kind-specific rule and the associated verbosity level, and less verbose levels
(or more critical levels).

Second filtering level based on the context:

From the remaining traces, all traces from the producers Multicam or Grablink are excluded from
the viewer buffer.
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Change the verbosity level for a kind

Kind available in the list

1. In the Verbosity pane, right-click the requested kind to access the context menu.

2. Select Set level and the requested verbosity level.

Kind not available in the list

This means the default verbosity level is applied to this kind:
1. In the Verbosity pane, right-click to access the context menu.
2. Select Add kind and the requested kind from the context menu.

3. Right-click the kind, then select Set level and the requested verbosity level from the context
menu.

Reset a kind to the default verbosity level

1. In the Verbosity pane, right-click the requested kind to access the context menu.

2. Select Remove kind from the context menu.

Exclude Analyzer traces from the viewer buffer

By default, the Analyzer traces are added to the viewer buffer.
To prevent them from being added, do the following:

1. In the Verbosity pane, click the kind corresponding to the Analyzer traces you want to
exclude from the viewer buffer.

2. Right-click and deselect Analyzer from the contextual menu.

The Analyzer setting for this row is now set to False and the Analyzer traces will not be added to
the viewer buffer.

Apply a configuration profile

The configuration profiles allow you to apply a predefined configuration to read filters.

For more information on configuration profiles, see "Use Predefined Configuration Profiles" on
page 64.

To change the configuration profile, do the following:
1. Right-click the Verbosity pane to access the context menu.
2. Select Load profile and the requested profile.

The traces will be added to the viewer buffer based on the loaded configuration profile.
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Exclude traces from selected producer(s), card(s), connector(s) and/or stream(s)

By default, the traces from all producers, cards, connectors and streams are included in the
viewer buffer.

This procedure explains how to refine exclude traces from given producers. You can proceed in
a similar way to filter traces from given cards, connectors and streams.

To exclude traces from one or more producers, do the following:

1. In the Context pane, click the Producer row, then right-click and select Adjust Producer filter to
display the contextual menu.

2. In the contextual menu, deselect the producer that you want to exclude the traces from.

3. Repeat step 1 and 2 to deselect other producers.

To exclude the traces from unidentified producers, deselect the None option.

NOTE
An exclamation mark (!) in the Filter column means no value is included for
the given context element. In this case, adapt the filtering for this element.

Include only traces from selected producer(s), card(s), connector(s) and/or
stream(s)

By default, the traces from all producers, cards, connectors and streams are included in the
viewer buffer.

This procedure explains how to refine include only traces from given producers. You can
proceed in a similar way to filter traces from given cards, connectors and streams.

To include only the traces from given producers, do the following:

1. In the Context pane, click the Producer row, then right-click and select Adjust Producer filter to
display the context menu.

2. In the context menu, click Unselect All.
3. Open again the context menu and select the producer that you want to include traces from.

4. Repeat step 3 to add other producers.

e To create an Includefilter, you can also define an Exclude filter, then
select Invert Selection at the bottom of the Producer list.

e Toinclude the traces from unidentified producers, use the None option.

Delete the producer filter

1. In the Context pane, click the Producer row, then right-click and select Adjust Producer filter to
display the context menu.
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2. In the context menu, click Delete Producer filter.

Reset all context filters to default

1. Right-click anywhere in the Context pane.

2. Select Reset all context filters to default.

7.3. Trigger Actions on Traces

"Memento Rules window" on page 58

Use of Memento rules

The traces extracted from the viewer buffer are displayed in the Memento application.

The Memento Rules allow you to trigger one of the following rule actions when a trace meets all
the rule settings defined in the rule:

e highlight traces in the message list (changing the background and/or the font color of the
trace information).

e hide traces.
e start / stop saving the traces into a dump file.

e stop in a Go Back action.

D NOTE

The Memento Rules are applied to all traces extracted from the viewer buffer
and displayed in the Memento application.

Access the Memento rules

From the Memento main window, select M in the Control bar, then Rules in the
Memento Configuration window.

Memento Configuration — X
File Edit

Memento Flow

Memento producers = Write Filters | = Memento storage (ring) = Read Filters | = Memento application = =» Action

The figure on the Rules button indicates how many rules are active.

The Memento Rules dialog box opens.
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Rules - [m] *
Edit
Enable | Mot ‘ ‘ Level | | Include ‘ ‘ Kind ‘ ‘ PID | | T ‘ ‘ Producer ‘ ‘ Card | | Connector ‘ ‘ Stream | Background | Text Color Action

1 [~ I Notice [ [ Userd r r r r r r Highlight

2 T MEwmer [ r r - r r F r | [

3F TV Wamin r r - r r F r |

4| I~ ¥ Notice [~ r r r r r r r Highlight

sV T Minfe T r r r r r r r I Hiohigh

6 [ ¥ Debug ™ r r r r r r r I Highlight

7|+ [~ ¥ Verbose [~ r r r r r r r Highlight

Apply Revert

Working principles of Memento rules

e A Memento rule includes a rule action that specifies the action to be performed, and rule
settings that specify the criteria that a trace has to meet for the rule action to be triggered.

e By default, rules 1 to 7 are predefined, but they can be modified. See Default Configuration.
e Only enabled rules and enabled settings in a rule are taken into account.
e The Memento application applies the rules from the smallest to the highest number.

e When a trace meets a rule and the rule action doesn't include "Continue", the action
associated to that rule is applied and the trace is not evaluated against another rule.

e When a trace meets a rule and the rule action includes "Continue", the action defined for
that rule is applied but the trace is reevaluated against the next applicable rule.

The last rule (without a "Continue" action) applicable to the trace is fully applied.

e When arule is based on a verbosity criterion, the rule applies to the traces having that
verbosity level and less verbose levels.

Refer the section Triggering Actions on Traces for practical applications of these principles.

Customize the trace display

Introduction

Rules with Highlight, Background, Text Color actions, and their Continue counterpart, allow you to
customize the trace display.

When such a rule is applied, it affects the trace display in the Trace column of the message list.

‘ Level | Trace | Comm... |
Verbose

Debudg EventsGetData: got data for 1 event

Info DSQueusBuffer (DS HANDLE hDataStream = 7, BUFFER HANDLE hBuffer = 17)

Debudg DMZ& chain still running (0x00000481 - Enable = 0, Bunning = 1, Waiting = 0)

Info DSGetInfo (DS HANDLE hDataStream = 7, STREAM INFO CMD iInfoCmd = 8, INFO DATATYPE *p

Info EventGetData (EVENT HANDLE hEvent = 13, woid *pBuffer, size t *piSize -> 16, uinté4

By default, the Memento rules 2 to 7 set a predefined highlight (background and text color)
based on the verbosity level.

See the section"Memento Rules window" on page 58 for a detailed description of the fields.
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Modify the trace display

To define or modify a rule to customize the trace display, proceed as follows:

1. In the Memento Rules window, do one of the following actions:
o To enable an existing rule, select the Enable check box and go to step 2.
o To disable an existing rule, deselect the Enable check box.

o To modify the settings and/or action of an enabled rule, go respectively to step 2 and/or
3.

o To add a new rule, right-click the row above which you want to add a rule and select Add
before from the context menu.

Other commands are available to add and move rows in the context menu.

2. In a given rule, define the rule setting you want to use:
o Select the check box in front of the rule setting.
o Type or select the value to be used as filtering criterion.

3. Inthe rule, define the requested action.
See "Action field" on page 61 for more information on the various actions.

4. If requested, invert the filter rule by selecting the Not check box:
o When the check box is not selected, the rule action is executed only when all the enabled
rule settings are met.
o When the check box is selected, the action is always executed except when all the
enabled rule settings are met.

5. If requested, change the rule position by selecting Move up current row or Move down current
row from the Edit menu.

6. Click Apply to apply the updated rule configuration to the data displayed in the Memento
application.

Example of rules using the Level parameter

Rules — O X
Edit
Enable | Mot ‘ | Level | | Include ‘ ‘ Kind | ‘ PID | ‘ TID | ‘ Producer ‘ | Card | | Connectorl | Stream | Background | Text Color Action

1| I ¥ Eror [~ r r r r r r r Highlight

2|7 ¥ Wamin [~ r r r r r r - I i hight

3| [~ ¥ Notice [~ r r r r r r C I i gkt

a7 e [ r r r r r r — I g gkt

5] [~ ¥ Debug [ r r r r r r C I Highiight

6|[v [~ ¥ |Verbose [~ r r r r I I r Highlight

7 [~ [ |Notice [ readout r r r r I I r _StopGoBack

In this example:

e With the rules 1 to 3, the traces of verbosity level Error, Warning and Notice have a specific
background to be more visible.

e With the rule 6, the traces of verbosity level Verboseand less verbose levels without an
enabled rule have no background and a light grey font color.

Consequently, the traces of verbosity level Info and Debug meet this rule.
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Example of rules using Level and Kind parameters

Rules - [m] x
Edit
Enable | Mot | | tevel | | ncude | [ kind | [Po| | 10| |  Producer | | card| | Connector | | Stream | Background | Text Color Action
1 [~ [ Erer [ r r r r [ [ N Highlight
2| [ [ Warnin|[_ r r r r r r C I ighiight
3|¥ [~ ¥ |Netice [ r r r r r r r I ighiight
i ~ Minfe [ ¥ 4Pl r r r r r r I Highlight
5(v ~ Mo [ Voma r r r r r I Highlight
6| - Mo [ r r r r r r - I iohight
7 [~ T |Debug [~ r r r r r r C I Highiight
8|[v [~ ¥ |Verbose [ r r r r [ [ N Highlight
9" [ " |Motice [V readout r r r r I I - |

In this example:

e The rule 3 applies to the traces with Notice verbosity and lower verbosity levels (Error,
Warning), as rules 1 and 2 are not enabled.

e Therules 4 and 5 apply to the traces with Info verbosity and respectively APl or DMA kinds:
these traces have a specific highlight.

e Therule 6 applies to the traces with Info verbosity and any kind other than APl or DMA: these
traces are all highlighted in the same way.

e The rule 8 applies to the traces with Verbose verbosity and lower verbosity levels without
specific rule (Debug): these traces are all highlighted the same way.

Example of rule using the Polarity parameter

Enable ‘ Not | ‘ Level ‘ | Include ‘ | Kind ‘ | PID | | TD ‘ ‘ Producer | ‘ Card ‘ | Connector ‘ | Stream ‘ Background | Text Color Action fal
1| [~ ||¥Info [ [+ pma [ F r T [ [ Highlight
2|V I~ |I¥ Info r ¥ 4Pl r — r — r r I oot
3 [ ¥infe r r r r r r r r | [
4F ¥ [¥info C C C C r C r r I ihioht
— — = — — — — — — — — .

In this example:

e With the rules 1 and 2, the traces of verbosity level Info and kind DMA or API have a specify
highlight (background and color).

e With the rule 3, other traces of verbosity level Info are highlighted differently.

e With the rule 4, where the Not parameter is selected, all traces with a verbosity level that is
notinfo have a dark red font and no background.

Example of rules using the Include parameter

Include | | Kind | ‘PIDl ‘TIDl ‘ Producer | ‘Cardl ‘Conne:torl |Stream Background | Text Color Action
Highlight

Enable | Not | ‘ Level |

1|V [~ ¥ Eror " " r r |’ r r |’

2¥ T ¥ Waming [ ~ r r r r r r i
3 [ ¥ Vebose |[¥[Camera readout: Start ]| C C r r r r I it
a|v [~ ¥ Vebose [ ~ r r r r r r I ichiioht

In this example:

e With the rule 3, the traces of verbosity level Verbose and less verbose (except Error and
Warning) that contain the text string Camera readout: Start will have a yellow background.

e With the rule 4, all other traces (except traces of verbosity level Error and Warning) will have
the same text color, but no background.
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Example of rules with Continue actions

Rules - [m] x
Edit

Enable [ Mot | | tevel | | incude | [ kind | [Po| | 10| |  Producer | | card| | Connector | | Stream | Background | Text Color
1|V [ ™Eror [ r r r r [ [ -
2|V [~ ¥ Warnin|[_ r r r r r r C I ighiight
3|¥ [~ ¥ |Netice [ r r r r r r r I ighiight
i ~ Minfe [ r r r r r r r I ;- roundindContinue
5(v [ ¥ Debug [~ r r r r r r r I TextColor
6 [ [7|verbose[ r r r r r r C
7 [~ T |Motice [# readout r r r r r r r T ;oG ot

Apply Revert

In this example:

e Therule 4 applies to the traces with Info verbosity only as all rules for traces with lower
verbosity levels are enabled:

Consequently, a pink background is applied to the traces with Info verbosity.

However, the traces with Info verbosity are evaluated against the next rule as the action in
rule 4 is BackgroundAndContinue.

e The rule 5 therefore applies to the traces with Debug and Info verbosity:

Consequently, a grey text color is applied to the traces with Debug and Info verbosity as the
action in rule 5 is TextColor.

Start or stop a backup to a dump file using rules

Using StartDump or StopDump rules in combination with Trigger Setup options set in the Dump
window allows you to start or stop automatically the backup to a dump file when a trace
matches the rule.

1. Add a row by right-clicking in the table and selecting Add before or Add Top from the context
menu.

If you define several StartDump or StopDump rules, the first trace that matches one of the
rules will trigger the rule action.

2. In the added row, define a rule with a StartDump or StopDump action and the settings a trace
has to meet to trigger the action.

3. Select the Enable check box to activate the defined rule.
4. Click Apply to save the changes in the rule configuration.

5. In the Dump window, set up the dump settings and initiate the dump file, as explained in the
procedure "Save future and/or past traces to a dump file from the Memento application” on
page 68.

If you have defined a StartDump rule, the dump file is initiated when you click Start in the Dump
window, but the traces start being backed up to the dump file only when a trace meets the
StartDump rule settings.

In the Dump window, the Start button changes to Waiting and the message Dump is waiting for
trigger is displayed at the bottom of the Dump window.
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Example of rules with StartDump actions

Rules - u] x
Edit
Enable | Not | | Level | | Include | | xind | |Po| |mo| |  Producer | | card| | Connector| | stream | Background | Text Color Action
1lv [~ [ Motice [¥ Low level downlink lock lost [ r r I I I r StartDump
2| I~ Femer [ r r r ~ ~ ~ r | Emm
3| I~ [¥emer [ r r r ~ ~ ~ r | | o
a|v [~ ¥ Wamin [~ r r r ~ ~ ~ r I Hichiight
5| I~ [¥ Motice [ r r - ~ ~ ~ r I Hishiight
6|[% I Fie [ r r ~ ~ ~ ~ r I it
7 [~ ¥ Debug [ r r r r r r r I Highiight
8|v [T ¥ Verbose [ r r r r r r r Highlight
9~ [~ [ Motice [# Camera readout r r r r r r r | EmE
Apply Revert

In this example, the rows 1 and 2 are StartDump rules:

e If a trace contains the Low level downlink lock lost text string, the traces from the ring buffer
will start being backed up to the dump file.

e If atrace of Error verbosity level is issued, the traces from the ring buffer will start being
backed up to the dump file.

Once you have initiated the dump file (clicked Start in the Dump window), the first trace that
matches one of these StartDump rules triggers the backup to the dump file.

Stop a Go Back action using rules

Using the StopGoBack rules in combination with the Apply StopGoBack rules option set in the Go
Back window allows you to stop in a Go Back action each time a trace matches the rule.

1. Add a row by right-clicking in the table and selecting Add before or Add Top from the context
menu.

The row position does not matter. If you define several StopGoBack rules, any trace that
matches one of the rules will trigger the rule action. So both rules will be applied.

2. In the added row, define a rule with a StopGoBack action and the settings a trace has to
meet to trigger the action.

3. Select the Enable check box to activate the defined rule.
4. Click Apply to save the changes in the rule configuration.

5. In the Go Back window, set up the Apply StopGoBack rules option to Yes, as explained in the
procedure "Go back to earlier stored traces" on page 20.

6. Click OK in the Go Back window

When the Go Back stops on a trace matching the StopGoBack rule, click Run to resume the Go
Back action.
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NOTE

If you disable a StopGoBack rule after starting a Go Back action, you need to
click Continue in the Go Back window for the rule to be effectively disabled in
the current Go Back action. Clicking Run in the main window is not
sufficient.

| J

Example of rules with a Go Back action

Rules - [m] X
Edit

Enable ‘ Not ‘ ‘ Level | | Include ‘ | Kind | | PIDl ‘ o ‘ ‘ Producer ‘ ‘ Card ‘ ‘ Connector | | Stream ‘ Background | Text Color Action
1¥ 7 [ Motice [ Low level downlink lock lost [~ r r - - - r HStartDump
2| [~ ¥Emwer [ r r r ~ ~ ~ r I - 0.
3| I~ [ Motice [ readoutCompleted r r ~ ~ ~ ~ r | e
Fiicd T FEmwer [ r r r r r r r | | [
5% [~ [ Wamin~ r r r r r r r 0 i
6|[¥ [~ [¥ Motice [~ r r r r r r r B ookt
77 r e [ r r r r r r r | [T
8|~ [~ ¥ Debug [ r r r ~ r r r I Highiight
9|[v [T ¥ Verbose[ N [ r I I I [ Highlight

Apply Revert

Enable rule

In this example, the row 3 is a StopGoBack rule:

e If a trace contains the readoutCompleted text string, the Go Back action will stop when finding
a trace containing this text string.

If more than one StopGoBack rule is defined, they will all be applied.

Increase or decrease the font size in the message list

To increase the font size, use one of the following keyboard combinations:
e PressZ

e Press CTRL + + (in the numeric pad)

To decrease the font size, use one of the following keyboard combinations:
e Press SHIFT +Z

e Press CTRL + - (in the numeric pad)

7.4. Memento Rules window

"Trigger Actions on Traces" on page 52

Access the Memento rules

From the Memento main window, select M in the Control bar, then Rules in the
Memento Configuration window.
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Memento Configuration — X
File Edit

Memento Flow
’7Memento producers = Write Filters | = Memento storage (ring) =  Read Filters | =+ Memento application = =» Action

The figure on the Rules button indicates how many rules are active.

The Memento Rules dialog box opens.

Rules - O >
Edit
r Enable' Notl | Level | | Include | | Kind | | P\D' | TID | | Producer | | Card| | Conne:torl | Stream | Background | Text Color Action
1[¥ I~ I Netice [~ [V Userd r r r r r r Highlight
2" T [¥Emr rC N o O - rC [ N iicih
3¥ [ Waminl r o o O r r r L [T
4 |7 I_ |7 Motice I_ l_ l_ l_ l_ l_ l_ l_ Highlight
s T Mo [ r - [ r r [ r I ichiight
6/ [ ¥ Debug [ r o o A r r r [ ighiight
7 |7 I_ |7 Verbosar l_ l_ l_ l_ l_ l_ l_ Highlight
Apply Revert
2 3
Rules - [m] X
@—.Edt
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Memento Rules window

Rule number (1)

The defined rules are displayed in a table and are identified by a number.
The rules are applied from the smallest to the highest number.

You can add or remove rules, as well as change the rule position using the Edit menu (4) and
context menu accessible via right-click (6).

See "Trigger Actions on Traces" on page 52 for detailed procedures.
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Rule settings (2)

Enable rules and rule settings

Each Memento rule (row) has controls to enable the rule, to define the rule setting as well as to
enable each rule setting

e For the rule to be applied, select the Enable check box.

e Forarule setting to be applied, select the check box in front of the given setting.

Enable | NotJ_I_ Level | | Include | | Kind | ‘ PID | | TID | | Producer ‘ ‘ Cardl | Cunnectorl | Stream ‘ Background | Text Color Action
r [ DMA I N r r r N Highlight

1T T [Fie

Field Description

Field Use

Select to enable a rule:
e When arule is enabled, it is applied to each trace that meets its enabled

Enable .
settings.
e When no rule is enabled, no trace is displayed in the message plot.
Select to invert a rule:
e When the Not check box is not selected, the rule is applied to traces that
Not meet all enabled settings.
e When the Not check box is selected, the rule is applied to all traces
except those that meet all enabled settings.
See example
Specify a verbosity level to apply the rule to traces that meet that verbosity
level.
Level The rule also applies to traces having less verbose levels than the one
specified if no other rule is defined for these verbosity levels.
See example
Specify a text string to apply the rule to traces that include the given text
string in the Trace column of the message plot.
Include . : oy
This parameter is case-sensitive.
See example
Kind
PID (Process ID)
TIP
(Thread ID) A setting is available for all message attributes specified in the left column.
e Select or enter an attribute value to apply the rule to traces that match
Producer . .
this attribute value.
Connector
Card
Stream
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Rule actions (3)

The following controls allow you to define the actions to be performed on the traces that meet
the rule settings.

Background and font color selectors

e The Background control allows you to select a background color to apply to the Trace field
value in the message list.

e The Color Text control allows you to select a text color to apply to the Trace field value in the
message list.

[ o

When the default verbosity rules (2 to 7) are defined in the Memento rules
window, the background color is also used for the trace display based on the
various verbosity levels in the message plot.

Action field
From the Action field, you can select the following actions:

Action name Description

This action hides, from the message list, the traces

Hide that match the rule settings.

This action hides, from the message list, the traces
HideAndContinue that match the rule settings and evaluates the next
rule for the current trace.

This action applies the values defined with the
Highlight Background and Text Color selectors to the traces that
match the rule settings.

This action applies the values defined with the
Background and Text Color selectors to the traces that
match the rule settings and evaluates the next rule for
the current trace.

HighlightAndContinue

This action applies the values defined with the
Background Background selector to the traces that match the rule
settings.

This action applies the values defined with the
Background selector to the traces that match the rule
settings and evaluates the next rule for the current
trace.

BackroundAndContinue

This action applies the values defined with the Text
TextColor Color selector to the traces that match the rule
settings.




Memento

Action name

cRresys

Description

TextColorAndContinue

This action applies the values defined with the Text
Color selector to the traces that match the rule
settings and evaluates the next rule for the current
trace.

This action starts saving the data from the ring buffer

StartDump to a dump file when a trace matches the rule settings.
See procedure and example.
This action stops saving the data from the ring buffer

StopDump to a dump file when a trace matches the rule settings.
See procedure and example

StopGoBack This action pauses a Go Back when a trace matches

the rule settings. See procedure and example.

D NOTE

When the default verbosity rules (2 to 7) are defined in the Memento rules
window, the Hide, Highlight, Background and their corresponding
...AndContinue actions also apply to the trace display based on the various
verbosity levels in the message plot.

Edit menu (4)

To perform a command on a specific row, first select the requested row.

You can also access most of these commands via the context menu by right-clicking on the

table.
Click ... in order to ...
Add on top add a row on the top of the table

Add before current row

add a row before the selected row

Remove current row

remove the selected row

Move up current row

move up the selected row to the next position

Move down current row

move down the selected row to the next position

Reverse and adapt actions

reverse the rule order and adapt the actions to keep
the same behavior.

( )

WARNING

Inverting the rules when the
default rules are enabled is more
CPU intensive as it requires to
evaluate each rule for all traces
from the most to the least
verbose level.

| J

Revert to default values

revert to the default rule configuration.
See "Default Configuration" on page 63.
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Command buttons (5)

The command buttons allow you to save the changes to the rule configuration or revert to the
initial configuration:

The buttons are enabled when the configuration has been modified but not saved yet.

Click ... in order to ...
Apply update the current configuration with the last unsaved changes.
Revert revert the changes since the last save.

Default Configuration

By default, the rule 1is enabled and configured to highlight user's traces. The rules 2 to 7 are
enabled and configured to highlight traces depending on their verbosity level.

Rule # Rule settings  Rule action
Kind=User0 Highlight - white background, green text

Level=Error - - red background, black text
Level=Warning Highlight - orange background, black text

Level=Notice  Highlight - white background, green text

Level=Info Highlight - white background, purple text

Level=Debug  Highlight - white background, grey text

N[O g~ W|IN|E

Level=Verbose - white background, light grey text

7.5. Save a Memento Configuration

When you save a Memento configuration, you save the configuration of the three filters you can
maintain in the Memento Configuration window.

Save the current configuration to a file

1. Click Config in the control bar.
2. In the Memento Configuration window, click File > Save configuration.
3. If requested, edit the file name and the file location for the configuration file

By default, the configuration file is called memento.config and is located in
C:\Users\<username>.

4. Click Save.

Load a configuration file to Memento

1. In the Memento Configuration window, click File > Load configuration.
2. Select the configuration file you want to load.
3. Click Open.
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7.6. Use Predefined Configuration Profiles

Use of configuration profiles

The Configuration Profiles allow you to quickly configure the write filters (for the ring buffer
configuration) or the read filters (for the viewer buffer configuration) by applying a predefined
configuration available in Memento.

Available configuration profiles

The following configuration profiles are available:

The HFR profile is a configuration optimized when using memento with high-frame-rate
applications.

The Verbose profile is a configuration with the maximum verbosity level for all message
kinds.

The Default profile is adequate for most use cases and prevents users from being
overwhelmed with too much information.

This configuration is similar to the Default profile, except that the traces from the hardware
are restricted to the warning and more critical levels.

The None profile allows users to disable the emission of new traces (with the write filters) or
the extraction of traces (with the read filters).

Where to use configuration profiles

Outside the Memento application, you can apply a configuration profile for the ring buffer
configuration using the config command in the command line tool or the options in the
Windows Start menu.

See "Setting up the Driver" in the Getting Started guide (D602).

In the Memento application, you can apply a configuration profile to the write filters or read
filters.

See "Filter Traces for the Memento Storage" on page 45 and "Filter Traces for the Memento
Application" on page 48.
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8. Saving Traces

8.1. Back up Memento Traces

Various ways for backing up Memento traces

For investigation purposes, you can back up traces from the ring buffer to a dump file in
different ways.

Two quick dump methods are available to:
e save all future traces to a dump file
e save a selection of past traces to a dump file

You can configure more complex dump processes, such as those presented below, as explained
in ""Save future and/or past traces to a dump file from the Memento application" on page 68":

e save continuously all or specific traces in one or more dump files.
e save a set of traces over a given time period or for a given number of traces in the future.

e save a set of traces from and/or to a specific event in the future, using the StartDump and
StopDump rules.

e save a set of traces in the past, ...

D NOTE

The dump file includes all the traces added to the ring buffer from a given
time point or position in the ring buffer. This does not take into account the
read filters as they are applied after the ring buffer in the message flow.

@ TIP

Always zip your dump file before sending it to the Support team.
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Save all future traces without opening the Memento application

Without opening the Memento application, you can start logging the future data added to the
ring buffer into a dump file (also called log file) as follows:

1. From the Windows Start menu E, select the command Euresys Memento > Start Memento

Logging.

Memento executes the following actions when you start logging:

o Memento creates a temporary dump file dumXXXX.memento saved to
%USERPROFILE%\memento\ where XXXX is an automatically generated alphanumeric
string. At this stage, Memento reserves the name dump.memento for the future dump file.
See the note below.

o Memento opens a command line window that displays the location of the file, and its
size. The file size is growing as data is being logged.

[ Lugglng Mementa miessages b Chllzers\Euresysimementa\dump.memento a X

Command line window - Data being logged to dump file

As long as the command line window remains open, Memento feeds continuously the dump
file with new data from the ring buffer.

2. Start your test application and reproduce the issue.
3. To stop logging cleanly and exit the command line window, press CTRL + C.
The temporary file is renamed to dump.memento.

4. Go to the location where the memento dump file has been saved, zip it and send it the
Euresys support per email if size permits.

NOTE

This quick dump process uses the Rotation options as follows: the dump file
is split when it exceeds 100 MB and up to 20 dump files are kept. This means
that any preexisting file named from dump.memento to dump.19.memento will
be renamed, and any preexisting file with an incremented number above 20

will be deleted.
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Save a selection of past traces to a dump file

If you want to save only a selection of former traces to a dump file to send it to the Euresys
support for investigation, you can select directly the relevant traces in the message list or use
bookmarks for the selection:

Back up traces selected manually to a dump file

1. In the message list, select the first message to save into a dump file.
2. Scroll to the last message to be selected and press CTRL + SHIFT to select all messages
between the first and the last.

3. Inthe Control bar, click the Menu button ﬂ and select Dump memento selection to file.

4. In the Dump memento to file window, select the folder where you want to store the dump
file and edit the name, if requested (keep the .memento extension).

5. Click Save.

6. (Optional) To open the dump file in Memento, click the Menu button again and select Open
Memento dump.

7. Go to the location where the dump file has been saved, zip it, and send it the Euresys
support per email if size permits.

The dump file includes the content of the ring buffer between the time stamps of the first and
last selected messages.

Back up traces selected between two bookmarks to a dump file

NOTE
This option is only available when at least two bookmarks have been
defined. See "Define Bookmarks" on page 31.

1. Inthe Control bar, clicki and select Dump memento section between bookmarks from the
menu, and the bookmarks to be used as boundaries for the dump file.

Dump memento data te file...
bkrm 0 and > | Dump memento section between bookmarks *
bkm 1 and -]
bkm 2 and >

2. In the Dump memento to file window, select the folder where you want to store the dump
file and edit the name, if requested (keep the .memento extension).

3. Click Save.

4. (Optional) To open the dump file in Memento, click the Menu button again and select Open
Memento dump.
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5. Go to the location where the dump file has been saved, zip it, and send it the Euresys
support per email if size permits.

The dump fill includes the content of the ring buffer between the time stamps of the selected
bookmarks.

Save future and/or past traces to a dump file from the Memento application

You can back up existing and/or future traces to a dump file. Various options let you define
precisely when you want to start and stop the trace backup.

"Dump Window" on page 70

1. Inthe Control bar, clickﬂ and select Dump memento data to file.
The Dump dialog box opens:

Setup

Rewind on start: 10s | Boot session: m
Follow traces: 10m -

Automatic restart: l@

Trigger

Apply StartDump rules: |Yes -
Apply StopDump rules: |Yes -

Rotation

Split size in MB: Mo Split -
Keep rotated dumps: | All -

File

Path or template: | ChUsers'\James\dump-${ts}.memento Browse...

Owverwrite without prompt: Mo =

Start

2. In the Setup, Rotation and File areas, you can set several options on the dump process itself,
or on the location and maintenance of the dump files. Refer to the section "Dump Window"
on page 70 for a detailed description of the various options.

3. In the Trigger area, specify whether you want to start/stop saving the traces to the dump file
based on a StartDump/StopDump Memento rule.

o If an option is set to No and a corresponding StartDump or StopDump rule is defined and
enabled in the Memento Rules window, this rule will be ignored.

o If an option is set to Yes and a corresponding StartDump or StopDump rule is defined and
enabled in the Memento Rules window, this rule will be taken into account: the dump will
start when the rule will be matched.

o If an option is set to Yes, but no corresponding StartDump or StopDump rule is defined
and enabled in the Memento Rules window, the dump will start immediately.
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Click Start to start saving traces to the dump file.

In the Dump file, the Start button turns to a Stop button, and the dump file size is displayed
at the bottom of the window.

Path or template: | ChUsers\Jameshdump-5${ts}.memento Browse...
HANDLE hBuf:
Overwrite without prompt: |Mo - b
| O CHD iInfol)
top EY *pEntries
Dump size: 30MB

Into EuresysEventsGetData (EURESYS EVENT GET DATA ENTRY *pEntries
Info DSGetBufferInfo (D5 _HRNDLE hDataStream = a, BUFFER HANDLE hB

Reproduce the issue you want to report and make sure the relevant traces appear in the
Message List.

After reproducing the issue, click the Stop button in the Dump window.

(Optional) To open the dump file in Memento, click the Menu button j and select Open
Memento dump.

Go to the location where the dump file has been saved, zip it and send it the Euresys support
per email if size permits.

The dump file is created by default in the Memento application directory
%USERPROFILE%\dump.memento\ or in the folder specified in the File section.

Example of Configuration for Automatic Dump

The following example shows how you can configure dump options to automate the dump file

process:
StopDump rule StopDump rule
matched matched
OR OR
Click Start SltmD”n;Pd = Follow traces » SltartDumhpd « Follow traces »
button fule matche value reached fule matche value reached

I v I v I .
| Rewind Auto. Rewind Auto. =

restart restart

When you click the Start button in the Dump window, the following happens:

1.

2.

As the Apply StartDump rule is set to Yes, the dump process is waiting for a StartDump rule to
be matched.

If no valid StartDump rule is defined in the Memento Rules window, traces start directly being
backed up to the dump file.

When a StartDump rule is matched, the traces start being backed up to the dump file.
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As a the Rewind on start is set to 10s in the example, the traces received on the last 10
seconds (before the StartDump rule is matched) are saved to the dump file too.

3. The traces stop being backed up and the dump file is closed when a StopDump rule is
matched or when the valued defined in the Follow traces option is met, whichever occurs

first.

4. As the Automatic Restart option is set to Yes, a new dump file opens automatically, and so on.

8.2. Dump Window

The Dump window allows you to define how to back up the traces stored in the ring buffer to

dump files.

To access this window, click ﬂ in the Control bar, and select Dump memento data to file:

Dump
Setup

Rewind on start: Mo

»| Bootseszion: |0 -

Follow traces: ez -
Automatic restart: |No - %
Trigger

Apply StartDump rules: |Yes -
Apply StopDump rules: |Yes -

Rotation

Split size in MB: [ No split_~|
Keep rotated durnps: m

File

Path or template: | ChUsers\James\dump-5${ts}.memento

Owverwrite without prompt: Mo =

Start

d >

Browse...
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Setup Options

Rewind

The Rewind option allows you to back up former traces in the current session. It specifies the
number of positions or minutes to rewind in the ring buffer before starting to dump traces.

Possible values are:

Value Description
No No rewind. Default value.
As far as possible Rewind as far as possible within the data of the specified boot session.

Rewind 1 second, 1 minute, 1 hour back within the data of the

Is, 1m, 1h specified boot session.

10, 100, 1000, 10000,

100000 Rewind 10, 100, 1000, 10000, 100000 positions.

Boot session

The Boot session option allows you to back up traces from former boot sessions. It specifies the
number of boot session to rewind to.

Possible values are:

Value Description

0 Current Boot Session. Default value.

Previous boot sessions. 1is the previous session the closest in time.
1,2,3 Thisis only available with Windows when data from previous sessions are still
available in the ring buffer.

This is not available with Linux OS and macOS.
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Follow traces

The Follow traces option makes it possible to stop the dump process when a specified number of
traces has been reached or a specified period of time has elapsed.

Value Description

No Memento stops saving to the open dump file and closes it when it no
longer receives new traces. Default value.

Ves Memento waits for more new traces and go on saving them to the

dump file.

Memento stops saving to the open dump file and closes it after a given

Positive number
number of traces has been saved.

Positive number with  Memento stops saving to the open dump file and closes it after the
suffix s, mor h specified time lapse.

NOTE
Memento can stop saving traces to the current dump file earlier if the Apply
StopDump rule is set to Yes and a StopDump rule has been matched.

Automatic restart

The Automatic restart option makes it possible to automatically restart backing up traces to a
new dump file when the previous dump has been stopped (due to a matched StopDump rule or
to the fulfilled Follow traces option).

Value Description
No A new dump is not restarted automatically. Default value.

A new dump file is automatically restarted:
o If Apply StartDump rules is set to No, Memento directly starts saving traces to the
Yes dump file based on the Follow traces setting.
o If Apply StartDump rules is set to Yes, Memento starts saving traces to the dump file
only when a StartDump rule is matched. In the meantime, it stays on Waiting status.

D NOTE

If the Automatic restart is set to Yes, you need to define a template for the
dump file name in the File section.

Trigger options

Apply StartDump rules

This option allows you to start backing up traces to a dump file only when a trace matches a
StartDump rule defined in the Memento Rules window.
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Apply StopDump rules

This option allows you to stop backing up traces to the dump file when a trace matches a
StopDump rule defined in the Memento Rules window.

See example of StartDump and StopDump rules.

Rotation options

Split size in MB

The Split size in MB option allows you to split the dumped data over multiple files by specifying
the maximum size for a dump file before a new dump file is created.

Possible values are:

Value Description
No Split  One dump file with unlimited size. Default value.

The dump file size is limited to respectively 256, 512 or 1024 megabytes:
When the split size is reached, new traces are saved to a new dump file.
256,512, Every time a new dump file is created:
1024 e The previous dump file is renamed by adding the file counter suffix .1.
e All existing dump files get their file counter suffix increased by one (the greater
the counter, the older the dump).

Keep rotated dumps

The Keep rotated dumps option allows to how many older dump files you want to keep. The
older ones will be deleted.

Possible values are:

Value Description

All Keeps all dump files. Default value.

Number (X) Keeps only the X most recent dump files.

File options

Path or template

This specifies the file path and the file name. The file name is fixed or variable, based on a
template.

When defining a template, you can use the variables ${ts} (timestamp) and/or ${cnt} (file
counter) that will be assigned when a new dump file is created.

NOTE
Using a variable file name is handy when you enable the Automatic restart
option.
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Euresys recommends to keep the filename suffix .memento.

Overwrite without prompt

The Overwrite without prompt specifies whether Memento will warn you before overwriting an
existing dump file.

This applies when a file with the same name as a former file has to be created.

Value Description

Memento warns you before overwriting an existing dump file if a new dump file with

No the same name has to be created. Default value.

Memento overwrite an existing dump file without warning if a new dump file with the

Yes .
same name is created.

NOTE
Setting the Overwrite without prompt option to Yes may be convenient when
you enable the Automatic restart option.
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8.3. Copy Messages

You can also copy and save traces into a spreadsheet for your own records. However, the dump
file remains the most appropriate source of information for the Euresys Support team to
investigate issues.

The following actions for copying messages can help you in this context:

Copy a selection of messages

1. Click the first message of your selection in the message list.

2. Scroll to the last message and simultaneously press SHIFT and click the last message to
select all messages between the first and the last.

3. Right-click and select Copy from the context menu.

Copy all displayed messages

e Right-click and select Copy all from the context menu.

Copy all occurrences of the same message or similar messages

1. In the message list, click the message that you want to copy all identical or similar
occurrences of.

2. Right-click and select on of the following options from the context menu:

n Copy same as: copies to the clipboard the content of all messages with the same
description in the Trace column as the currently selected message.

o Copy similar to: copies to the clipboard the content of all messages with a similar
description in the Trace column as the currently selected message.

Similar messages are messages where only the attribute values may differ compared to
the selected message.

Once the messages are copied to the clipboard, simply paste them to the requested application.
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9. Using Time Information

You can use the following tools to get additional time information related to the traces:

Change the time reference

In the message list, the Delta field value is used as the time reference. By default, the first trace
displayed message list gets the time reference +0.000000 (with microseconds precision) whether
the viewer buffer is read in real-time monitoring or using the Go Back function.

If the number of traces to be displayed exceeds the maximum capacity of the viewer buffer
(250000 entries), the first visible trace might have a different time reference.

To set the time reference to another message than the first displayed message, do one of the
following actions:

e Right-click the message to be assigned the time reference and select Set time reference from
the context menu.

e Click the message to be assigned the time reference and press T from the keyboard.

Measure time interval between two traces

e Press SHIFT and simultaneously click and drag the mouse between both traces to measure
the time interval.

The red line symbolizes the calculated time interval displayed in orange.

The time interval between two bookmarks is automatically displayed on the
message plot when allowed by the zoom level.

Inject current timecode in the ring buffer

A message containing the current UTC date and time of kind Time and the verbosity level Notice
is inserted at regular intervals into the ring buffer. This provides a sync point between the
Memento time scale and the system time, itself possibly synchronized to an Internet Time
Server.

When you are monitoring the process in real time, you can also inject manually such a message
in the ring buffer:

e Right-click the message list and select Inject current time trace from the context menu.
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10. Administration Tools

The following administration tools are available from the Menu button il in the control bar:

Clear search history to clear the history of the search strings in the Search field.

Clear all user preferences to clear the history of all user preferences (read filters, layout
preferences, etc.). The write filters and rules are not reset with this control.

Clear Analyzer preferences to clear the Analyzer configuration.

Clear history before bookmark to clear the message list before the selected bookmark
(available when at least a bookmark is defined).
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11. Appendix 1 - Keyboard Shortcuts

Memento Keyboard Shortcuts — a x
Action I Shortcut I
Search Text F3
Enter
Search Text Backwards Shift+F3
Shift+Enter
Repeat Search M
Repeat Search Backwards Shift+M
Enable Search Text Field /
Copy cell contents to search Y
Go to Top G
Home
Go to Bottom Shift+G
Go to Bottern and follow End
Increase font size Ctrl+Num +
il
Decrease font size Ctrl+Mum -
Shift+Z
Copy current trace to clipboard Ctrl+C
Reset time reference on current trace T
Jump to next trace with same cell contents Mum *
J
Jump to previcus trace with same cell contents Mum -
Shift+)
Jump to next trace with similar cell contents Shift+Mum *
)
Jump to previcus trace with similar cell contents Shift+Mum -
Shift+5
Jump to next error E
Jump to previcus error Shift+E
Jump to next warning w
Jump to previcus warning Shift+W
Jump to next notice o}
Jump to previcus notice Shift+ 0
Jump to next APl function call (with level Infa) A
Jump to previcus AP function call (with level Info) Shift+A
Jump to next user trace U
Jump to previous user trace Shift+L
Freeze tooltip Shift
Toeggle bookmark F4
Toeggle bookmark information in plot regions F&
Teggle measure information in plot regions (double-click) F7
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12. Appendix 2 - Creating Memento

Dumps

Creating Memento dumps for Euresys technical support

Introduction

What is Memento? See eGrabber Memento page on the Euresys web site.
Where to get Memento? Memento is part of the Coaxlink series download page.
Three methods are available to create a Memento dump:

1. "Creating Memento dumps using automatic saving" on page 80

2. "Creating Memento dumps using manual saving (All)" on page 81

3. "Creating Memento dumps using manual saving (Selection)" on page 84


https://www.euresys.com/en/products/software/egrabber-memento/
https://www.euresys.com/en/download-area/
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Creating Memento dumps using automatic saving

E

l Euresys Coaxdink

. Euresys Memento
@ Memento
@ Record Memento and XPerf traces
| Reset Memento to Default Verbosi...
| Set Memento to Highest Verbosity...

Ue| Start Memento Logging

1. Start Memento from the start menu under Euresys Memento and select Start Memento Logging

Lagging Memento messages to ChUsers\Euresyshmementadump.memento O >
1

Connecting to Memento... Done. ~

2MB

Memento will start logging everything and save the logs to a folder defined in the title of the
logging windows.

2. Start now your test application and see that the amount of recorded data increases.
3. Once you are finished, just <Ctrl>+<C> to stop logging window.

4. Go to the location where the Memento log has been saved , zip it and send it the Euresys
support per email if size permits.
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Creating Memento dumps using manual saving (All)

E

l Euresys Coaxdink

. Euresys Memento
Memento
Record Memento and XPerf traces
Reset Memento to Default Verbosi...
Set Memento to Highest Verbosity...

Start Memento Logging

1. Start Memento from the start menu under Euresys Memento and select Memento.

Euresys Memento — O X

[~ &a [ RE Search: - Config... | Following | Pause | Clear | Go Back... =

2. Click the overflow Menu button (triple lines) to open the Option Menu.

Clear search history
Clear all user preferences

Clear analyzer preferences
Dump rmemento data to file...
Inject current time trace
Reload trace definition

~  Enable analyzer

Show analyzer

About...

3. Select Dump memento data to file... option, this will open a saving dialog.
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Dump O >
— Dump Setup

Rewind: I Mo j

Boot session: IE
— Dump Rotation Setup

Split size in MB: | No Split_~|

Keep: Iﬂ
— Trigger Setup

Apply StartDump rules: IE

Apply StopDurnp rules: m

—File Setup

File: I ChUsers\Euresys\durnp.memento Browse...

4. In this dialog box you can select:

o if you want to save data from a previous session (section Dump Setup)
if you want to split the dump of the log file into multiple files or a single file

O
o if you want to define specific rules to start and stop the recording
O

where you want the log file to be saved, as well as its name

5. Once you have selected the most appropriate option press Start button

@euresys

a TKH Vision bra:
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Delta |[pp |0 |c.c.Kind Level Trace 1 |

+817.265923 10484 10092 API Info GenapiGetString|TL HANDLE hTL
+B17.265945 10484 10092 BRPI Info GenapiGetStringl|TL HANDLE hTL
+B17.265960 10484 10092 BPI Info GenapiGetString|TL HANDLE hTL
+B17.265975 EScrin HANDLE hTL
+817.265997 s - = X EString ]'_:Z-E!.ND]'_E hTL
+£817.266015 | Dump Setup FC (PORT HANDLE hPort =
+817.266041 | p_ IND L‘ Fr (PORT HANDLE hPort =
+817.266062 EString (TL_HANDLE hTL
+817.266084 || DoOt session: IE EString (TL _HANDLE hTL
+817.266090 |_pump Rotation Setup Pt (PORT_HANDLE hPort =
+B17.266184 EString (TL HANDLE hTL
+817.266192 | °plitsize in ME: IN':'E'F’“t "I Pt (PORT HANDLE hPort =
+817.266229 || Keep: All = Ft (PORT HANDLE hPort =
+B17.266241 Et (PORT HANDLE hPort =
+817.266252 || 1119ger Setup Ft (PORT HANDLE hPort =
+317.266261 || Apply StartDump rules: IE, EString (TL HANDLE hIL
+B17.266266 rt (FORT HANDLE hFort =
+817.266280 || PP StopDump rules IYe;jv tt(PDRT:I-lP.NDLE nPort =
+817.266510 |- File Setup Et (PORT HANDLE hPort =
+817.266530 rt (PFORT HANDLE hPFort =
+817.266542 || File | C\Users\Euresys\dump.memento Browse... | bt (PORT HANDLE hPort =
+B817.266568 Et (PORT HANDLE hPort =
+B17.266581 EString (TL HANDLE hTL
+817.266589 |Dump size: 277KB Ft (PORT HANDLE hPort =
+817.266603 10454 #p052 aeTf Info GCReadPort (PORT HANDLE hPort =
+B17.266615 10092 A Info GCReadPort (PORT HANDLE hPort =
+Bl?.2668092 10092 3 I Info GCReadPort (PORT HANDLE hPort =
+817.266827 0484 10092 API Info GCReadPort (PORT HANDLE hPort =
+817.266863 10484 10092 API Info GCReadPort (PORT HANDLE hPort =
+817.266910 10484 10052 API Info GCReadPort (PORT HANDLE hPort =

6. Start to reproduce the issue you want to log, make sure that traces appear in the trace list
(see 1in picture) then dump size should also be increasing ( see 2 in picture) finally once you
have reproduced completely the issue you can click the Stop button ( see 3 in picture) to stop

the recording of the Memento dump.

7. Go to the location where the Memento log has been saved , zip it and send it the Euresys

support per email if size permits.
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Creating Memento dumps using manual saving (Selection)

Beuresys

Time: 23779.540552s, Delta: +10.421373s

l Euresys Coaxdink

Memento

Record Memento and XPerf trace

Rezet Memento to Default Verbosi...

rbosity...

Click and drag to scroll left/right, Shift-Click and drag to measure, Shift-Ctri-Click to toggle bookmark, Right-Click and drag to zoom in, (Ctri-)Wheel for (faster) zoom in/out

162543

10484
10484
10484
10484
10484
10484
10484
10484
10484
10484
10484
10484
10484
10484
10484
10484
10484
10484
34.300512

APT
API
API
API
API
API
Hardware
Hardware
DMA
API
API
API
API
LPI
API
APT
API
LPI
APT
API
API
API
API
RPI
LPI
APT
API
API
BPI
API

char
iAddres
t (DS_HANDLE hDataStream st char
ort (PORT_HANDLE hPort i 1 4 t iAddr
. HANDLE hDataStream =

Camera re

tream 7, STREAM INFQ

ntGetData (EVENT HANDLE hEvent = 11, d *pBuffer,
DSGetBufferInfo (D5 HANDLE hDataStream BUFFER_HANDLE
D5GetBufferIn: D5_HANDLE hDataStream BUFFER_HANDLE
D5GetBufferIn: D5_HBNDLE SUFFER_HANDLE
D5GetBufferln: D5 HANDLE UFFER HANDLE

GetBufferIn: . HANDLE UFFER_HANDLE
D5GetBufferIn: D5_HANDLE BUFFER_HANDLE
D5GecInfo (D5_HANDLE hDataStream = 7, STREAM INFO CMD iIn;
DSGetBufferInfo UFFER HANDLE

» void *pB

EFER_HANDLE hBuffer = 12)

ut started at 238033667

i

INFOQ DATATYEE #*
16, uinté4d

= 14, BUFFER INFO|

hBuffer =
hBuffer =
hBuffer =
hBuffer
hBuffer
il
hBuffer =

t iValue = 0x1080001, unsigned char *s

char # - unsigned int

o (D5 _HANDLE hData.

Image rert t ImageConvertInput *input, const ImageC

ImageConvert: conversion done in us
GenapiGetFloat (DS _HANDLE h

GCReadPort (PORT HANDLE hPort s 54t iAddres

Stream = char *sFeature =
0x03ee2440

14, BUFFER _INFOQ

14, BUFFER INFO

14, BUFFER INFO|
14, BUFFER_INEOQ

14, BUFFER_INEQ

INFO_DATATYPE *
14, BUFFER

rmat,
*piValue)
BUFFER HANDLE hBuffer = 14, BUFFER INFO|

wertCutput utput, con|

GenapiGetFloat (DS _HANDLE hData! ol char *sFeature =

GCReadPort (PORT_HAWNDLE hPo ui iAddr =0
GenapiGetFloat (DS _HANDLE hData:

03£14400

const char *sFeature

StatisticsFrameRa

GCReadFo ui 4 iAddre = 0x03ef440001000000,

D5QueueBuffer (D
Low level downlink lock lost
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2. Start the process that reproduces the issue you want to log, once you have seen the issue
you want to report, press Pause, click on the first line you want to record and <shift> click
on the last line, make sure that your selection is highlighted in blue, see picture, consider
adding more lines to enable the support to better understand the context in which the issue
happens.

[@] Euresys Memento — O >
¥

[~ &a [ RE Search: A Config... | Following | Pause | Clear | Go Back...

3. Click the overflow Menu button (triple lines) to open the Option Menu.

Clear search history
Clear all user preferences

Clear analyzer preferences

Dump memento data to file..

Durnp memento selection to file...
Inject current time trace
Reload trace definition

~*  Enable analyzer

Show analyzer

About...
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@euresys

a TKH Vision bra

4. This time select Dump memento selection to file... option, this will open a selection saving

dialog.

Dump memento to file

et
i a ¥ Euresys » v Search Euresys o
Organize - Mew folder wE v 9
b Ter:nplates Tools Videos 3genicamst dumF735. e
7F Quick access art.mermen memento
to
I Desktop +
* Dl:lwnll:lads x
Docurnents o ]
_ dump.l.me  timecut300
&= Pictures b mento O.memento w
File name; | v
Save as type:  Memento file o
~ Hide Folders Cancel

5. Select the location and name of the log recording file.

6. Go to the location where the Memento log has been saved , zip it and send it the Euresys

support per email if size permits.
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13. Glossary

A

activity plot

Area in the Memento application (GUI) that displays a plot of the number of
Memento traces recently added to the Memento ring buffer. In other words,
this shows the recent activity of the Memento producers.

Analyzer plot

Area in the Memento application (GUI) that displays waveforms
representing events and state changes occured over a time frame in
selected steps of the image acquisition process.

Analyzer trace

Specific Memento traces that can help users analyze, detect and
understand issues during system component discovery and defects during
image acquisition. Such traces are displayed in the Analyzer plot.

M

Memento application

User interfaces of the Memento system. The Memento application is
available in two modes: a "Console" mode allowing users to interact with
the Memento system in command line, and the "GUI" mode allowing users
to interact with the Memento system via a graphical user interface.

Memento message

1. Message built by the lightweight macro executed on the Memento
producer side and added to the Memento ring buffer. 2. Text information
displayed in the Message list of the Memento application. This is more
restricted than a Memento trace as it does not cover the graphical
representation of a Memento trace.

Memento producer

Frame grabber driver and library, or user space application that write
event-related or status-related messages to the Memento ring buffer
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Memento rules

Set of filters allowing users to customize the display of the Memento traces
in the Memento application. Formerly called "Highlighting filters".

Memento trace

1. Event-related or status-related information, and its associated metadata
(for example Producer ID, criticality level, etc.), generated by a Memento
producer and displayed in the Memento application. It covers its graphical
representation in the Memento GUI. 2. Lightweight software macro that is
executed on the Memento producer side and writes messages in the
Memento ring buffer.

message context

Classification on Memento traces based on their origin (producer, card,
connector and/or stream)

message kind
Classification of Memento traces based on their nature, type (or origin)

message list

Area in the Memento application (GUI) that displays a filtered set of
Memento traces.

message plot

Area in the Memento application (GUI) that displays a plot showing the
Memento traces issued over a time frame based on their severity.

R

read filter

Filter used to define the traces to be extracted to the viewer buffer and
displayed in the Memento application. Formerly called "verbosity filters".

read filter configuration

Filtering of the traces added to the Memento viewer buffer by means of the
read filters.

ring buffer

Common memory space reserved by the Memento driver on the computer,
in which the Memento producers write event data. This is also called the
Memento storage.
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\Y

verbosity level

Classification of Memento traces based on their content criticality and on
the requested amount of messages to be displayed. The levels are the
following from the least verbose (most critical) to the most verbose (least
critical): Critical, Error, Warning, Notice, Info, Debug, Verbose.

viewer buffer

Memory area where the Memento application stores the traces that comply
with the read filters and have to be displayed in the Memento application.

W

write filter

Filter used to define the messages to be added to the Memento ring buffer
based on their kind and the requested verbosity level. Formerly called "ring
filters".

write filter configuration

Filtering of the messages added to the Memento ring buffer by means of the
write filters. Also called "ring buffer configuration".
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